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Preface

Welcome to the JD Edwards EnterpriseOne Tools Translations Tools Guide.

Audience

This guide is intended for translators who are responsible for translating JD Edwards
EnterpriseOne software.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/us/corporate/accessibility/index.html.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http://www.oracle.com/support/contact.html or visit
http://www.oracle.com/accessibility/support.html if you are hearing
impaired.

Related Documents

You can access related documents from the JD Edwards EnterpriseOne Release
Documentation Overview pages on My Oracle Support. Access the main
documentation overview page by searching for the document ID, which is 876932.1, or
by using this link:

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id
=876932.1

To navigate to this page from the My Oracle Support home page, click the Knowledge
tab, and then click the Tools and Training menu, JD Edwards EnterpriseOne, Welcome
Center, Release Information Overview.

This guide contains references to server configuration settings that JD Edwards
EnterpriseOne stores in configuration files (such as jde.ini, jas.ini, jdbj.ini,
jdelog.properties, and so on). Beginning with the JD Edwards EnterpriseOne Tools
Release 8.97, it is highly recommended that you only access and manage these settings
for the supported server types using the Server Manager program. See the Server
Manager Guide on My Oracle Support.


https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1 
https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1 

Conventions

The following text conventions are used in this document:

Convention Meaning

Bold Indicates field values.

Italics Indicates emphasis and JD Edwards EnterpriseOne or other
book-length publication titles.

Monospace Indicates a JD Edwards EnterpriseOne program, other code
example, or URL.
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Introduction to JD Edwards EnterpriseOne
Translation Tools

This chapter contains the following topics:
s JD Edwards Translation Tools Overview

» JD Edwards Translation Tools Implementation

1.1 JD Edwards Translation Tools Overview

Oracle's JD Edwards EnterpriseOne Translation Tools are tools that translate JD
Edwards EnterpriseOne software products from a source language, such as English,
into multiple target languages quickly and efficiently.

1.2 JD Edwards Translation Tools Implementation

This section provides an overview of the steps that are required to implement JD
Edwards Translation Tools.

In the planning phase of the implementation, take advantage of all JD Edwards
sources of information, including the installation guides and troubleshooting
information.

1.2.1 JD Edwards Translation Tools Implementation Steps

The following implementation steps need to be performed before working with JD
Edwards Translation Tools:

1. Install JD Edwards EnterpriseOne.
See JD Edwards EnterpriseOne installation documentation for the platform.
2. Install one or more JD Edwards EnterpriseOne applications.

See JD Edwards EnterpriseOne installation documentation for the applications.

Introduction to JD Edwards EnterpriseOne Translation Tools 1-1
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Understanding JD Edwards EnterpriseOne
Software

This chapter contains the following topics:
ms  Section 2.1, "Prerequisite"

s Section 2.2, "JD Edwards Translation Tools Overview"

2.1 Prerequisite

Before you begin translating JD Edwards EnterpriseOne software, you should become
familiar with the guidelines for ]D Edwards EnterpriseOne application development
and any other appropriate ]D Edwards EnterpriseOne documentation.

See Also:

s "Understanding Application Development Guidelines" in the JD
Edwards EnterpriseOne Tools Development Guidelines for Application
Design Guide

2.2 JD Edwards Translation Tools Overview

JD Edwards EnterpriseOne software supports manufacturing, financials, distribution
and logistics, and human resource operations for multisite and multinational
organizations. An organization's business needs determine what product lines are
installed in its enterprise system. Complex business situations might require several
product lines to achieve a comprehensive solution. The JD Edwards System combines
those applications with an integrated toolset and tailors them to meet the needs of
each business.

Product lines are created from combinations of systems. For example, the JD Edwards
EnterpriseOne Financial Management product line includes system 03B (Accounts
Receivable), system 04 (Accounts Payable), system 09 (General Accounting), system 12
(Fixed Assets), and other systems. Systems, in turn, consist of executable functions,
forms, reports, database tables, and other components that are designed for specific
business needs.

You use JD Edwards Translation Tools to translate each component of each system in
JD Edwards EnterpriseOne software.

Understanding JD Edwards EnterpriseOne Software 2-1
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Using JD Edwards Translation Tools

This chapter contains the following topics:

Understanding JD Edwards Translation Tools
Understanding the JD Edwards Translation Tools Interface
Accessing ]D Edwards Translation Tools
Reviewing Audit Information for a Delta Process
Setting JD Edwards Translation Tools Options
Checking the Spelling of Translations

Changing Item Status

Entering Translations Manually

Copying Translations

Using Suggestions

Using Source and Target Preview

Using Keyboard Shortcuts

Searching and Replacing Text

Approving Target Items

Saving Translations

3.1 Understanding JD Edwards Translation Tools

Oracle's JD Edwards EnterpriseOne Translation Tools provide these features:

Contextual references.

As you translate the interface, you can view items in context

Consistency features.

You can view previously translated terms to ensure a consistent translation.
Automated translations

When you select an item to translate, JD Edwards Translation Tools searches the
database for that item. If it finds a match, JD Edwards Translation Tools
automatically displays the translation.

Using JD Edwards Translation Tools 3-1



Understanding JD Edwards Translation Tools

In most translation applications, items appear in context. For example, all items within
a task appear together, and the items of a form are displayed the way that they appear
in the software so that you can view the context while translating.

During the translation cycle for a new release of JD Edwards EnterpriseOne software,
the items to be translated are made available to the translators through the Delta
Process. The Delta Process extracts the translatable items from the software, stores
these items in a JD Edwards-supported database, and assigns status codes to the items.

When extracting the translatable items from the software, the Delta Process compares
the new release of JD Edwards EnterpriseOne software with the previous release to
locate the changes, and assigns a status of 20 (Untranslated) to new or changed items.

As you translate using JD Edwards Translation Tools, you update items on a JD
Edwards-supported database every time that you click OK.

Important: The system has no lock capability, and two or more
translators can access and translate the same item at the same time.
The last translation saved is the translation that is reflected in the
system. If two or more translators are working on the same system,
they should divide their work to ensure that they do not overwrite
each other's work.

JD Edwards EnterpriseOne software contains a variety of product lines that relate to
different departments within an organization, such as distribution, manufacturing,
and human resources. Multiple systems reside within each product line.

You might be assigned to translate the human resources and financial verticals. As you
translate different systems, you will notice that, due to the subject of the applications,
terms used in one system are not used in others.

Although you can translate the software items in any order, you should translate the
software interface in this order:

1. Glossary entries (using a translation memory such as TRADOS).
Data dictionary items.

Processing options.

Formes.

Reports.

Menus.

Tasks.

User defined codes.

© ® N o o & 0O DN

Resource files.

10. Miscellaneous items.

3.1.1 Consistency Features

JD Edwards Translation Tools provide features that enable you to translate
consistently. Because a single term can have multiple meanings, you should translate
source terms consistently throughout a system. You use consistency features to ensure
that previously translated terms are consistent with current translations.

3-2 JD Edwards EnterpriseOne Tools Translation Tools Guide
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3.1.2 Suggestions

When you select a previously translated item, JD Edwards Translation Tools enters the
selected translations in the Source and Target translation fields. You can set up JD
Edwards Translation Tools to suggest the previous translation or to always suggest the
data dictionary description, even when the item has an override.

The suggestions for previous translations come from the source language database. JD
Edwards Translation Tools enables you to add new suggestions as well as edit existing
ones.

3.1.3 Space Constraints

A fixed amount of space is available for each translatable item. Because translated
information requires varying lengths of text, you might have to abbreviate the
translations. When you have exceeded the number of bytes allotted for an item, the
system generates one of these warnings:

s Abbreviate the translation.
s Use another term.

s Check the preview. (Many forms have maximum and minimum buttons that
enable the user to control the length of the controls.)

3.1.4 Translating Controls

The amount of space that is available for the translation is measured either in
characters or pixels, depending on the type of control that is chosen. This table
contains the nine types of controls that are available and whether the control uses a
pixel- or character-based measurement:

Control Space Measurement
Push Button Pixel-based

Check Box Pixel-based

Radio Button Pixel-based

Static Text Pixel-based

Group Box Pixel-based

Hyper Button Character-based
Bitmap Character-based

Text Variable Character-based
Form and Grid Controls Pixel-based

3.1.5 Search and Replace

Each JD Edwards translation application except FASTR, Favorites, and Menus includes
a search-and-replace feature. Each tool has slightly different search-and-replace
functionality and, depending on the type of text, requires separate search criteria. You
access the search-and-replace feature from each tool separately. For example, you
cannot perform a search of user-defined code (UDC) items and replace them using the
F79750: Form Design Aid (FDA) tool.
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3.1.6 Spell Check

You can use the Microsoft Word spell check feature with most JD Edwards Translation
Tools. Before using spell check in JD Edwards Translation Tools, you must select the
appropriate language options in Microsoft Word. You can use spell check only for
single-byte languages. You should use the spell check feature before you save
translations.

3.1.7 Default Codes

Within JD Edwards Translation Tools, all translatable items must have a status code.
Status codes indicate:

»  The status of each translatable item.
= Whether the item is ready to be packaged in the software.
n  The location of the item in the translation process.

As you translate, you enter the appropriate status codes to ensure that the source
terms do not appear in the software. During the software mastering process, only
translated items with these statuses appear in the software:

s Complete (status = 11).
s  FDA/RDA DD Default (status = 15).
s Review (status = 25).

If a translated item has any other status codes assigned, the source term for that
translated item appears in the software.

In addition to the status codes, two other types of codes further define the translatable

item:
s Reason
] Sklp

The Delta Process updates the Reason code to indicate the type of change (for
example, a text or size change). You update the Skip code to indicate why you did not
translate the item (for example, the item is test data or a translation is not needed for
the language). If you assign a Skip code to an item, the Source text appears in the
software.

3.1.8 Translatable JD Edwards ltems

The translatable items in JD Edwards EnterpriseOne software include:
= Data dictionary items

The data dictionary stores the text items that are used for row and column
headings, alpha descriptions, and glossaries (F1 or field-level helps) for reuse.
When translating these text items, you should view the associated glossary entry,
if available, to understand the context of the data dictionary item and to ensure
that you are using consistent translations.

s Glossary entries

Glossary entries describe data dictionary items and their use in the software. You
can view glossaries from multiple applications by using JD Edwards Translation

Tools. Being able to view the glossaries from multiple applications enables you to
see their context while you translate. You translate each entry using a translation

memory, such as TRADOS.
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Because glossaries can contain hundreds of lines of information, they are among
the most time-consuming components to translate.

Processing options

You can use processing options to configure many JD Edwards applications
according to your needs. Processing options enable you to supply parameters to
control how a program functions. For example, processing options enable you to:

- Specity defaults for certain form displays.
- Control the format in which information appears on reports
— Change how a form displays information.

You translate all of the tabs and the processing option text on the processing
option forms.

Forms

When you access an interactive program, a form appears. Each form contains a
title and a variety of controls such as tabs, grids, and hyper controls, all of which
must be translated.

Reports

Similar to forms, reports contain controls and titles that must be translated.
Column items and section controls correspond to data dictionary items.

Tasks

JD Edwards EnterpriseOne software contains task menus that enable access to
subtasks, applications, reports, and executables. As you translate tasks, all task
items and submenus appear together so that you can view them in context.

User-defined codes

User Defined Codes (UDCs) are codes and descriptions in the software that
provide you with an easy way to select a value from a list. UDCs are stored in
tables within JD Edwards EnterpriseOne software, and you access them from these
tables.

Each user-defined code contains a description of the option as well as a code for
that option. You translate only the descriptions; the codes remain the same in
every language.

Resource files

Resource files (for example, files with extensions such as .rc, .dll, .exe) are
applications that are generated by third-party tools (for example, Java and C++)
that appear throughout JD Edwards EnterpriseOne software. These items are not
JD Edwards items, but they must be translated into the target language, or users
will see source text. These files include error messages, toolbar menus, and the
legal disclaimer.

Miscellaneous items

A few items in the JD Edwards EnterpriseOne software interface cannot be
included in any of the previous categories, and JD Edwards Translation Tools does
not recognize them. These miscellaneous items are contained in specific tables
within the JD Edwards EnterpriseOne software and include user-defined time
periods and the names of the months. You translate miscellaneous items by using
the FASTR and Favorites applications.

Using JD Edwards Translation Tools 3-5



Understanding the JD Edwards Translation Tools Interface

You can use JD Edwards Translation Tools to translate all items. However, you can use
a translation memory, such as TRADOS, to translate glossary items for processing
options and data items.

3.2 Understanding the JD Edwards Translation Tools Interface
This section discusses:
s Information common to all tabs.

= Source and target panes.

3.2.1 Information Common to All Tabs

Many of the tabs on the Fix/Inspect forms in Oracle's JD Edwards EnterpriseOne
Translation Tools contain the same information. You should be familiar with this
information before using JD Edwards Translation Tools.

The examples in this chapter are taken from different translation tools. However, you
can find the information defined in all translation tools.

3.2.1.1 View

The View tab contains display and option information for individual items, files, and
objects.

3.2.1.2 Audit

The Audit tab contains audit trail information for an individual translation item or for
an object.

The status totals are the total number of translation items that were transferred when
the last Delta Process was run.

The translator or translation audit information identifies who last translated an item,
when it was translated, and so on.

The audit trail information provides detailed information about who accessed an item.

3.2.1.3 Glossary

The Glossary tab contains the glossary information for items that have glossaries. Each
Glossary tab contains header information, for example, the data item name and a
description.

The Glossary tabs contain two panes. The top pane is the source pane or untranslated
text. The bottom pane is the target pane or translated text. You cannot always change
the text in these panes. The Translating the Data Dictionary section of this guide
explains all you need to know about the Glossary tab and translating data dictionary
items.

3.2.2 Source and Target Panes

The source and target panes are located in the common area. The common area is
located in the lower section of almost all of the forms of JD Edwards Translation Tools.
When you click an item in the detail area, the current source and target text appears in
the fields in the common area.
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Pane Explanation

Source Displays the term or text in source language.

The application also uses this field to store
variable-length terms or text for use by JD
Edwards Translation Tools.

Target Displays the term or text in target or

translation language. The application also uses
this field to store variable-length terms or text
for use by JD Edwards Translation Tools.

All common areas in JD Edwards Translation Tools forms contain status, change type,
and skip reason information for the individual item that you select to translate.

3.3 Accessing JD Edwards Translation Tools

This section provides an overview of translation tool navigation and discusses how to
access translation tools.

3.3.1 Understanding Translation Tool Navigation

You access all JD Edwards translation tools through the Translation Applications menu
(GH791). On the Translation Applications menu, all translation applications appear in
a tree. When you access any of the translation tools for the first time, the system
displays default information. When you access the tools; you see the information that
you entered when you last quit the program (for example, product code, status, and so
on). No translation items appear until you search for them.

3.3.2 Accessing JD Edwards Translation Tools

To access any translation tools:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator.

The Senior Translations version of the program automatically updates the
translation item status to 11 (Complete) from a status of 20 (Untranslated) or 25
(Edit/Review).

The Junior Translations version of the program automatically updates the
translation item status to 25 (Edit/Review) from a status of 20 (Untranslated). If
the item is already at a status 25, the status does not change automatically.

To begin translating, click Translation Tools, and then select one of the translation
applications (for example, F7920: Resource Text Translations (RTT).

Click OK.

Note: Subsequent navigations in JD Edwards Translation Tools
documentation assume that you are a senior translator.

3.4 Reviewing Audit Information for a Delta Process

You can review the audit information for a Delta Process to ensure that the Delta
Process has been run over the items that you want to translate. The Delta Process
determines what development changes have occurred in JD Edwards translation tables
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over a specific period. The process compares the ]D Edwards translation tables, as they
are at the time that you run the process, with the production or mastered versions, as
they were when you last ran the process.

To review audit information for a Delta Process:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then Translation Tools.

2. On the View tab, click a translation tool, and then select the Audit tab.

3. Review appropriate fields.

3.5 Setting JD Edwards Translation Tools Options

You can configure the appearance and performance of ]D Edwards Translation Tools to
suit the translation style and to enable the system to assist you in translation.

This section discusses how to:

= Set display options.

= Select the Move by Status feature.
= Move from item to item.

= Use auto hot keys.

3.5.1 Setting Display Options

You access the translation applications from a tree. You can configure the tree to either
limit or expand the view of the data items that you want to translate. Click these
options to define the view.

Source
Display only the source text.

Target
Display only the target text.

Both
Display both the source and target text.

3.5.2 Select the Move by Status Feature

The Move by Status feature enables you to specify which translation items appear
when you finish translating the current item. The Move by Status feature moves to the
next item at the status that you specified on the Find /Browse (Work With...) form.

For example, if you are working only on translation items at status 20 (Untranslated)
with the Move by Status feature selected, the system displays only those items at
status 20. You can specify any status in the translation process.

To select Move by Status:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then select any of these translations tools:

- F79750: Form Design Aid (FDA).
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- F79760: Report Design Aid (RDA).
- F98306: Processing Options (PO).
2. On the Find/Browse form (Work With...), complete the Status field and click Find.

The status that you specify here is the status at which the system displays the
records when you select Move by Status.

3. Select an item from the detail area and click Select.
4. In the translation application that you are using, select the Move by Status option.
5. Enter the translation in the Target field and click OK.

The translation tool saves the translation and then displays the next item with the
same status.

3.5.3 Moving from Item to Item

JD Edwards Translation Tools enable you to move from item to item without having to
quit the translation tool in which you are working. You have two options that enable
you to move from item to item:

s Move Previous and Move Next.

s Previous and Next.

3.5.3.1 Using the Move Previous or Move Next Options

The Move Previous and Move Next options enable you to view the items in the detail
area of the previous Work With form. You can use both of these options to move from
item to item in the detail area of the Work With form on which you searched for items.

You can use the Move Previous and Move Next options only in these JD Edwards
Translation Tools:

s F79750: Form Design Aid (FDA).
s F79760: Report Design Aid (RDA).
= F98306: Processing Options (PO).

3.5.3.2 Using the Previous and Next Options

You use the Previous and Next options for much the same reason that you use the
Move Previous and Move Next options. The Previous and Next options, however, are
different in these ways:

= They function independently of the Move by Status option.

= They move to the next or previous item in the detail area of the previous Work
With form regardless of whether you select Move by Status.

While you can use the Previous and Next options in all of the JD Edwards Translation
Tools, you might find that you do not need them in the tools that have the Move
Previous and Move Next features.

3.5.4 Using Auto Hot Keys

A hot key is a key sequence that automatically launches a shortcut when pressed (for
example, CTRL + C is a hot key for the command Copy). The Auto Hot Key feature
enables you to automatically copy the source hot key into the target translation.
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Alternatively, you can manually copy the hot key from the source field into the target
field if the source and target hot keys are the same.

3.6 Checking the Spelling of Translations
This section lists a prerequisite and discusses how to:
»  Check spelling manually.
»  Check spelling automatically.

3.6.1 Prerequisite

Close all sessions of Microsoft Word before you run spell check in JD Edwards
Translation Tools. If Microsoft Word is open when you run spell check, Microsoft Word
might shut down without saving any work that you have open.

3.6.2 Checking Spelling Manually

Before you advance to the next item to be translated, you can check the spelling of the
item. The Spelling tab highlights any misspelled words.

To check spelling manually:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then select any translation tool.

2. Locate and select any translation item other than a glossary item.
3. Select Spell Check from the Form menu.
Misspelled words appear in red.
4. Correct any spelling errors.
5. Click one of these options:
- OK

The JD Edwards Translation Tool saves the translation, updates the status, and
displays the next item in the Source data field.

- Save

The JD Edwards Translation Tool saves the translation and updates the status.

3.6.3 Checking Spelling Automatically

You can specify that JD Edwards Translation Tools automatically spell check the
translations as you enter them. To do so, select the Auto Spell Check option. This task
demonstrates how to select the Auto Spell Check option in the F7920: Resource Text
Translations tool. You can use the Auto Spell Check feature in almost any tool.

To check spelling automatically:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translation (RTT).

2.  On Work With Resource Text Translation, complete the Selected File Name, Status,
and Language fields and then click Find.
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3. (Click an item in the tree menu and then click Select.
Alternatively, you can double-click a translation item in the tree menu.

4. On the Resource Text Translation form, select the Auto Spell Check option.

3.7 Changing Iltem Status

This section provides an overview of item status and discusses how to change item
status manually.

3.7.1 Understanding Item Status

Each time that you revise a translation item and click OK, the system automatically
updates the item status. The next status that the system selects in the translation
process depends on which version of the tool you are using. This table describes the
versions and the next status to which the system moves a translation item when you

click OK.

Translation Tool Version Assigned Status

Senior Translations 11 (Complete) from a status of 20
(Untranslated) or 25 (Edit/Review)

Junior Translations 25 (Edit/Review) from a status of 20

(Untranslated)

If the item is already at status 25, the status
does not change.

You can manually change the status of the translation process. For example, if you are
using a Senior Translations version and you are unsure whether the item is translated
accurately, you can change the item to 25 (Edit/Review) to indicate that it should be
reviewed.

3.7.2 Changing Item Status Manually

To change item status manually:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

2.  On Work With Resource Text Translation, complete the Selected File Name, Status,
and Language fields, and then click Find.

The default value in the Status field comes from a processing option for the
version that you are using.

The default value in the Language field comes from the JD Edwards user profile.
3. Select an item and click Select.
4. Translate the item and click OK.

The F7920: Resource Text Translations (RTT) tool saves the translation with the
appropriate status code based on the version (junior or senior) that you are using.
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3.8 Entering Translations Manually

This section provides an overview of manual translation and discusses how to enter
translations manually.

3.8.1 Understanding Manual Translation

When you begin translating items, the system provides suggestions from previous
translations. These suggestions come from the source language database. The system
populates the target fields with these suggestions. You can enter translations manually,
such as when the item is new and you do not agree with the suggestion or when the
suggestion is a "fuzzy" match that would require a great deal of editing. (A fuzzy
match is a source text that only partially matches the target text.)

You can enter translations manually on forms in any of the JD Edwards Translation
Tools.

3.8.2 Entering Translations Manually

To enter a translation manually:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

2.  On Work With Resource Text Translation, complete the Selected File Name, Status,
and Language fields, and then click Find.

3. Select an item in the tree menu and then click Select.
Alternatively, you can double-click a translation item in the tree menu.
The Resource Text Translation form displays the source text.
4. In the Target field, enter the translated text.
5. Click OK.
JD Edwards Translation Tools saves the translation and updates the status.
6. Click Next.
JD Edwards Translation Tools displays the next item in the list.

3.9 Copying Translations

This section provides an overview of translation copying and discusses how to copy
the source item.

3.9.1 Understanding Translation Copying

Many times the source text is a sufficient explanation for the target item or you cannot
translate the target item. You can use these features to copy information from the
source text fields into the translation target fields:

Feature Description

Copy Source Copies the text for all source fields to the
translation target fields.
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Feature Description

Copy Alpha Copies the translation for the alpha

description into the row and column
translation fields. (Use this feature for data
dictionary translation only.)

Copy Row Copies the translation for the row description

into the translation field for the column
description. (Use this feature for data
dictionary and translation tools only.)

Copy Previous Copies the translation for the last saved

translation into all translation fields.

Copy Tab Copies the translation from the Short Name

field to the Long Name field. (Use this feature
for processing options translation only.)

Note: For data dictionary items, always translate the alpha
description first so that the copy functions are available for the row
and column translations.

3.9.2 Copying the Source ltem

If the source item has no translation in the target language, you can copy the source
item into the Target field.

You should copy source text only to help you format the translations; you should
never save the source text as the translation. If the source text does not require
translation, assign the item a status of 30 Other (Skip Reason). Status 30 bypasses the
translation for that item. If you do not assign status 30 to the item, the system displays
the source text.

To copy the source item:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

On the Work With Resource Text Translation form, complete the Selected File
Name, Status, and Language fields and click Find.

Select an item and click Select.

The Resource Text Translation form displays the source item in the Source field.
Select Copy Source from the Form menu.

The source item appears in the Target field.

Translate the item.

Click OK.

3.10 Using Suggestions

This section provides an overview of suggestions and discusses how to:

Search for suggestions manually.

Search for suggestions automatically.
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= Add translations as suggestions.

s Update and delete suggestions.

3.10.1 Understanding Suggestions

JD Edwards Translation Tools ensure consistency and save time by enabling you to use
items that have already been translated. When JD Edwards Translation Tools finds a
previously translated item, it automatically completes the Target field so that you can
use the suggestion and immediately go to the next untranslated item.

Alternatively, you can search for translated items manually. When using suggestions,
you should consider whether you want to retrieve suggestions manually or let the
system retrieve them automatically, and whether you want to save the translations as
suggestions.

The suggestions data field, located in the lower right of the translation tool forms,
contains these entries:

= None.
No appropriate translations exist for this source term.
= Exists (Loaded).

The data field contains a lightning bolt button, which indicates that a suggested
translation is available for this source term. When you click the button, the
Suggestion -Search & Select form appears. You then can search for the most
appropriate translation for the source term.

s  More Exists.

The data field contains a lightning bolt button, which indicates that more than one
suggested translation is available for this source term. When you click the button,
the Suggestion -Search & Select form appears. You then can search for the most
appropriate translation for the source term.

s DD Default.

The data field contains a light bulb button, which indicates that appropriate
translations are available for this source term. When you click the button, the Data
Dictionary Translation form appears.

s Not checked.

Based on the status of the term, the system did not search the database for any
suggested translations.

You can use the Suggestions form in any of the JD Edwards Translation Tools except:
= F83100: FASTR Date Title.

= F83100: FASTR Column Headings.

= F91100: Favorites Relationships and Properties.

You also can access it directly From the Translation Applications menu (GH791) by
choosing either Senior Translations or Junior Translations, depending on the role, and
then choosing Suggestions from the Form menu.

3.10.1.1 Searching for Suggestions Manually

JD Edwards Translation Tools enable you to manually search for and use previously
translated items. You manually research translations when you are not satisfied with
the default suggestions.
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3.10.1.2 Searching for Suggestions Automatically

If you are translating items with a status 20 (Untranslated), you can use JD Edwards
Translation Tools to automatically search for and use previously translated items. JD
Edwards Translation Tools alerts you if it finds more than one option for the item that
you are translating. You can make the search general or more specific by selecting the
number of characters that you want to search on in the Source term. For example, you
can specify the search by directing the software to retrieve only those items that match
the first 40 characters of the Source term. Alternatively, you can make the search more
general by directing the software to retrieve only those terms that match fewer
characters.

3.10.1.3 Updating and Deleting Suggestions

After you have created a suggestion for one item of source text, you cannot add an
additional suggestion for that exact source text. If the record exists, the system does
not add another.

You might update the suggestion if:
»  The text has changed slightly.

»  The space requirements have changed (you have either more or less space for the
translation).

You might delete the suggestion if:
= The source text is obsolete.
s The suggestion was added by mistake.

» ltis easier to delete the suggestion and enter another than to update the current
one.

3.10.2 Searching for Suggestions Manually

To manually search for suggestions:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

2.  On Work With Resource Text Translations, complete the Selected File Name and
Language fields and then click Find.

3. Select an item in the detail area, and then click Select.
Alternatively, you can double-click a translation item in the detail area.

4. On the View tab of Resource Text Translation, ensure that the Suggestions option is
selected.

5. In the Length field, enter the number of beginning characters that you want JD
Edwards Translation Tools to search when finding matches.

For example, if you enter 5, JD Edwards Translation Tools uses the first five
characters of source text to search for and retrieve matching translated items.

- If JD Edwards Translation Tools finds only one term and the Target field is
blank, it automatically loads the text into the Target field. If the existing
translation is accurate for the item, continue to step 7.

The Suggestion Search & Select button also appears here.
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- If JD Edwards Translation Tools finds more than one term, it displays the
Suggestion Search Select button with the text More Exists.

6. Select Suggestions from the Form menu.

Note: The compressed description in the Source Search Text data
field contains the search text without spaces, slashes, dashes, commas,
or other special characters. The compressed description is the field
used in the Data Dictionary Name Search.

7. To search for translations, on Suggestion - Search & Select, enter search criteria in
the appropriate fields on the form and click Find.

8. Select the translation that you want to use from the detail area, and click Select.

The Resource Text Translation form appears, displaying the translation that you
chose from the Target data field.

9. Click OK.
The JD Edwards Translation Tool saves the translation and updates the status.

10. Click Next to move to the next translation item.

3.10.3 Searching for Suggestions Automatically

To automatically search for suggestions:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

2.  On the Work With Resource Text Translation form, complete the Selected File
Name, Status, and Language fields, and then click Find.

3. C(lick an item in the detail area, and then click Select.
Alternatively, you can double-click a translation item in the detail area.
4. Ensure that the Suggestions option is selected.

5. In the Length field, enter the number of beginning characters that you want JD
Edwards Translation Tools to search on when finding matches.

For example, if you enter 5, JD Edwards Translation Tools uses the first five
characters of source text to search for matching translated items.

- If JD Edwards Translation Tools finds only one term and the Target field is
blank, it automatically loads the text into the Target field. If the existing
translation is accurate for the item, continue to step 7.

The Suggestion Search & Select button also appears here.

- If JD Edwards Translation Tools finds more than one term, it displays the
Suggestion Search & Select button with the text More Exists.

Note: The compressed description in the Source Search Text data
field contains the search text without spaces, slashes, dashes, commas,
or other special characters. The compressed description is the field
that is used in the Data Dictionary Name Search.
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Click the button or select Suggestions from the Form menu if you are not satisfied
with the suggestion that was loaded.

On Suggestion - Search & Select, select the translation that you want to use.
Click Select.

The Resource Text Translation Text form appears, displaying the text that you
chose from the Translation field.

Click OK.

The JD Edwards Translation Tool saves the translation and updates the status.

10. Click Next to move to the next translation item.

3.10.4 Adding Translations as Suggestions

You can add the translations as a suggestion for you or other translators to use later.

To add a translation as a suggestion:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

On Work With Resource Text Translation, complete the Selected File Name, Status,
and Language fields, and then click Find.

Click an item in the detail area, and then click Select.
Alternatively, you can double-click a translation item in the detail area.

On the View tab of the Resource Text Translation form, ensure that the Suggestions
option is selected.

In the Target field, enter the translation for the current item, and perform one of
these actions:

— Click OK.

Automatically saves the translation to the code page as well as the
Translations Suggestions (F7910) table as a suggestion if the Suggestion option
selected on and the suggestion does not already exist.

—  From the Form menu, select Add Suggestion.

Saves the translation to the F7910 table.

3.10.5 Updating and Deleting Suggestions

You can update or delete a suggestion using the Translation Suggestion Search and
Select (P7910S) program. You can access this application from any of the JD Edwards
Translation Tools. The JD Edwards Translation Tools themselves do not update or
delete suggestions.

To update or delete suggestions:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator.

On EnterpriseOne Translation Tools select a translation tool.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator.
Select Suggestions from the Form menu, and then complete steps 5 through 8. You
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8.
9.

10.
11.
12.

might want to do this if you need to go directly to Suggestions to perform
maintenance on the suggestions.

These steps use the Resource Text Translations tool as an example.

On Work With Resource Text Translation, complete the Selected File Name, Status,
and Language fields, and then click Find.

Click an item in the detail area, and then click Select.
Alternatively, you can double-click a translation item in the detail area.

On Resource Text Translation, select the Suggestions option, and then select
Suggestions from the form menu.

On Suggestion - Search & Select, locate the record that you want to update or
delete.

Select the record in the detail area, and then select Update Suggestions from the
Form menu.

If no suggestions appear in the detail area, you must add one.

On Work With Translation Suggestions, complete the Source Search Text,
Language, and Product Code fields (if needed), and then click Find.

Select a record in the detail area, and then click OK.

If you want to delete the suggestion, click Delete and then go to step 9.
If you want to update the suggestion, click Select and then go to step 8.
Update or delete the suggestion in the Target field, and then click OK.
Click Cancel.

3.11 Using Source and Target Preview

JD Edwards Translation Tools offer many features to help you further refine the data,
structure, and physical appearance of the translations. These features help you refine
the translations:

Feature Description

Source Preview This feature enables you to view source

objects as they appear in the software. Use the
source preview to review software objects in
the source language for content and format as
you make translation choices.

Target Preview This feature enables you to view target objects

as they will appear translated in the software.
Use the target preview to review the software
objects in the target language for content and
format as you make translation choices.

These JD Edwards Translation Tools have Source Preview and Target Preview:

F79750: Form Design Aid (FDA).
F79760: Report Design Aid (RDA).
F9203: Data Dictionary (DD) Alpha.
F98306: Processing Options (PO).

3-18 JD Edwards EnterpriseOne Tools Translation Tools Guide



Searching and Replacing Text

To use source or target preview:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then select any translation tool with source or target preview.

2. Select an item in the detail area.
3. From the Form menu, select one of these options:
— Source Preview

— Target Preview

3.12 Using Keyboard Shortcuts

Using keyboard shortcuts saves you valuable time when translating. You can use these
keyboard shortcuts to move between tabs and items on the EnterpriseOne Translation
Tools forms.

Keyboard Shortcut Description

Ctrl+Tab Moves between tabs from left to right.

Ctrl+Shift+Tab Moves between tabs from right to left.

Alt+X Moves to the next item on a Find /Browse
(Work With...) form.

Alt+V Moves to the previous item on a Find/Browse
(Work With...) form.

Alt+O or Enter OK.

Ctrl+End Moves to the last selection in the detail area.

3.13 Searching and Replacing Text

This section presents an overview of the search and replace workspace and discusses
how to:

s Use wildcard characters.
»  Define general search criteria.
s Define search text.

» Find and replace target items.

See Also:

s Chapter 14, "Understanding Jargon and Overrides".

3.13.1 Understanding the Search and Replace Workspace

The Search and Replace tool exists in all of the tools except:
= F83100: FASTR Date Title.

= F83110: FASTR Column Headings.

= F91100: Favorites Relationships and Properties.
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When you replace a translation and save it, JD Edwards Translation Tools enables you
to proceed to the next item on the list. Continue replacing translated items until you
have completed the list for all of the applications.

The Search and Replace workspace consists of a form with three or four of these tabs:
General, Application, Search Text, and Find /Replace. The number of tabs depends on
which translation tool you are using.

3.13.1.1 General Tab

When you access the Search and Replace tool from a JD Edwards Translation
application's Find /Browse (Work With...) form, the form that appears consists of the
upper and lower common areas with the detail area in between. The detail area of the
General tab is the only area that is different for every application.

The General tab enables you to further define the search criteria. For example, if you
know the from date translated and the through date translated, you can limit the
search to that period of translation.

3.13.1.2 Application Tab

When you access the Search and Replace tool from an application's Find /Browse
(Work With...) form, the form that appears consists of several tabs. The Application tab
is different for each of the four applications. Each Application tab consists of data
fields that you use to define the search and replace.

The Application tab on Form Design Aid (FDA) enables you to further define the
search criteria. For example, if you know the form name and the data item, you can
limit the search to that form and the data item that appears on it.

The Application tab on Report Design Aid (RDA) enables you to further define the
search criteria. For example, if you know the object name, you can limit the search for
the text on only that object.

The Application tab on Processing Options (PO) enables you to further define the
search criteria. For example, you can limit the search according to PO text type.

The Application tab on Solution Explorer Tasks enables you to further define the
search criteria. For example, if you know the task ID, you can limit the search for the
text on that object only.

3.13.1.3 Search Text Tab

When you access the Search and Replace tool from an application's Find /Browse
(Work With...) form, the form that appears consists of several tabs. All Search Text tabs
are the same for each application.

3.13.1.4 Find and Replace Tab

When you access the Search and Replace tool from an application's Find /Browse
(Work With...) form, the form that appears consists of several tabs. The Find and
Replace feature enables you to find specific search strings of translated text for the
application that you are in and replace them with a new or updated translation. You
can replace each instance individually or you can replace all instances. The Find and
Replace tab is the same for each application.

When you select the Replace Translation option, the system searches for the selected
source translation that matches the term in the detail area that you want to replace.
When the system finds a match, the source translation appears in the Source field, and
the proposed replacement translation appears in the Target field. You have these
choices when you replace text:
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Replace Option Description

Replace Replaces only current text and remains on that
text.

Replace Next Replaces only current text and finds the next
text match.

Replace All Replaces all text in the detail area with

matching criteria and returns to the top of the
grid.

3.13.2 Using Wildcard Characters

You can use wildcard characters to expand the search or if you are not sure of the
spelling of the search term. Several types of wildcards exist. JD Edwards Translation
Tools use an asterisk (*).

An asterisk substitutes a string of characters of any length at the beginning of the
string, the end of the string, or both. Asterisks specify 0 (zero) or more alphanumeric
characters. You can use wildcards to obtain special results. This table illustrates
wildcard use in the Search and Replace tool (where string equals any alphanumeric

string).
Search Text
Search String Description Example Source Results Target Results
string* Begin Wild Code* Code Page Pagina de codigo
*string End Wild *Code Purge Code Codigo de
depuraci?n

*string* Total Wild *Code* Managerial Code de analisis

Analysis Code1 gerencial 1
string Exact Code Code Codigo

3.13.3 Defining General Search Criteria

Access the Work With Resource Text Translation form.

To define the general search criteria:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

On the Work With Resource Text Translation form, complete any of these fields
and click Find.

— Selected File Name

— Status

- Language

From the Form menu, select Search / Replace.

The system updates the header of the Search and Replace form with some of the
information that you entered in the header area of the Work With Resource Text
Translation form, such as Selected File Name and Language. However, the system
does not update the Status field with the value from the Status field on the Work
With Resource Text Translation form. Instead, it supplies the default value of 11
(Complete) because you normally want to search for completed items only.

Using JD Edwards Translation Tools 3-21



Searching and Replacing Text

Depending on the application from which you access the Search and Replace
feature, different search criteria appear. For example, if you access the Search and
Replace feature from F0004: User Defined Code (UDC) Types and the fields in the
header contain values, the search criteria are the product code and the language.

4. On the General tab, complete any of the search fields, and then click Find.

Note: You can search only for these statuses when using the Search
and Replace feature: 11 (Complete), 20 (Untranslated), and 25
(Edit/Review).

After you define the general search criteria and review the results in the detail area,
you can either define the search text or find and replace target items.

3.13.4 Defining Search Text

To define the search text:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

2.  On Work With Resource Translations, complete any of these fields and click Find:
— Selected File Name
— Status
- Language

3. From the Form menu, select Search / Replace.

4. On Search and Replace, select the Search Text tab.

The system updates the detail area of the Search and Replace form with the
information from the General tab.

5. To further define the search, complete any of the search fields, and then click Find:

Primary Search Description

Source An option that specifies whether the system
searches for a match on the source description
first and then the target description. If the
system finds a match, it then checks the target
description for a match based on the search
criteria chosen in the secondary search

Target An option that specifies whether the system
searches for a match on the target description
first and then the source description. If the
system finds a match, it then checks the source
description for a match based on the search
criteria chosen in the secondary search.

3-22 JD Edwards EnterpriseOne Tools Translation Tools Guide



Searching and Replacing Text

Secondary Search Description

Case Sensitive An option that specifies whether the search is

case sensitive. If you select this option, it
applies to the primary search that you did not
select. For example, if Source is selected in
Primary Search, the case sensitivity option
applies to the Target field.

Equal To An option that specifies whether the system

returns items to the detail area for which the
source and target items match. If you select
this option, the system returns only those
items for which both the source and the target
items contain the string that you entered in the
Source or Target field. If you do not select this
option, the system returns only items for
which the source matches but target does not.

After you define the search text and review the results in the detail area, you can
find and replace target items.

3.13.5 Finding and Replacing Target ltems

To find and replace target items:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

On Work With Resource Text Translation, complete any of these fields and click
Find:

- Selected File Name
- Status
— Language
From the Form menu, select Search / Replace.
On Search / Replace, select the Find /Replace tab and complete these fields:
- Find
- Replace with
From the Form menu, select one of these options:
- Next
The system selects the next item in the detail area.
- Replace
The system replaces the current item in the detail area.
- Replace / Next

The system replaces the current item and then selects the next item in the
detail area.

- Replace All
The system replaces all items in the detail area.

— Previous
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The system selects the previous item in the detail area.
- Top
The system selects the uppermost item in the detail area.
You can find and replace these types of text strings:
s Text strings with other text strings only.
s Text strings with text strings containing spaces.
s Text strings with spaces only.
s Text strings with nulls.

This table illustrates a sample search. One carat (*) equals one space.

Search Text Replace Field

Example Text String Type Find Field Text Text Target Results

*Code* Other text strings *Coédigo* C?dXigo C?dXigo

*Code* Text strings Codigo* *CAnnNdigo® CrnNedigo
containing spaces

Code* One blank Codigo* *AC?digo* NC?digo

Code* More than one Codigo* *C?2dA N Nigo* C?d A Nigo
blank

Code* Null Codigo* * (blank)

3.14 Approving Target ltems

You can use the Search and Replace Tool to approve target items; for example, target
items changed by the Multiple Release Exact Match program (P7903).

This section lists a prerequisite and discusses how to approve target items.

3.14.1 Prerequisite

Set the processing options for version ZJDE0003 (Quality Assurance) of JD Edwards
Translation Tools program to 36:Exact Match.

3.14.2 Approving Target ltems

To approve target items:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

2.  On Work With Resource Text Translation, select Search / Replace from the Form
menu without completing any fields.

The system updates the header of the Search and Replace form with some of the
information that you entered in the header area of the Work With Resource Text
Translation form, such as selected file name and language. However, the system
does not update the Status field with the value from the Status field on the Work
With Resource Text Translation form. Instead, it supplies the default value of 11
(Complete) because you normally want to search for completed items only.

Depending on the application from which you access the Search and Replace
feature, different search criteria appear. For example, if you access the Search and
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Replace feature from F0004: User Defined Code (UDC) Types and the fields in the
header contain values, the search criteria are the product code and the language.

On the General tab, complete these fields and click Find:
— Status

Filter Status = 36:Exact Match
- Language
— Last Translator

Last Translator = XTRANS (eXact TRANSIation)
Select a record in the detail area.

From the Form menu, select Review Approved to update items to 11 (Complete).

3.15 Saving Translations

When you save a translation, JD Edwards Translation Tools saves the translation to the
Code Page Environment and perform these actions:

If you click OK, JD Edwards Translation Tools saves the translation, updates the status
code to 11 (Complete) in the compare environment, and automatically displays the
next available item in these JD Edwards Translation Tools:

F79750: Form Design Aid (FDA).
F79760: Report Design Aid (RDA).
F98306: Processing Options (PO).

For all other JD Edwards Translation Tools, you use the Next or Previous buttons
to display the next available item for translation.

If you click Save on the preceding applications, the current item is saved; however,
the next available item does not automatically appear.

The status that you apply to a translated item depends on the status of the item when
you opened it. If the item's status was 20 (Untranslated), each tool updates the status
to the default value that is specified in the processing options for that tool, which is
either 11 (Complete) or 25 (Edit/Review).

Important: You must save the work after each translation. The
system does not prompt you to save the translation before choosing
another item, so be sure to save the work.
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Translating Resource Text

This chapter contains the following topics:
s Understanding Resource Files
s Translating Service Pack Resources

s Translating Resource Text

4.1 Understanding Resource Files

Resource files (for example, files with extensions such as .rc, .dll, .exe) are the
applications that are generated by third-party tools (C++ and Java). They appear
throughout JD Edwards products and include error messages, toolbar menus, and the
legal disclaimer. Resource file items can be a single word or a short paragraph. To
ensure consistency, one translator should translate all resource files for one language
using the Resource Text Translation program (P79201) in Oracle's JD Edwards
EnterpriseOne Translation Tools. Resource files occur throughout JD Edwards
EnterpriseOne software; they are grouped by file rather than product code.

You translate all resource items using the F79201: Resource Text Translations (RTT)
tool. In addition to translating items, you can retrieve and use existing translations,
check the spelling of the text, change the status of an item, save translated items,
search for and replace target text, and so on.

You have three options when translating resource files. You can enter a translation
manually, copy the source text that has already been translated manually, or use
suggestions.

Many items in the resource files include a hot key. Hot keys can be localized to a
specific language, but standards should be followed for consistency.

Because resource files are not grouped by product code, you generally translate them
in the order that they appear in the tool (RTT). Resource text, however, is grouped by
the resource file and parent identifier.

Note: Resource files have names such as jdeuser.dll, and the items
are contained in these files. The parent identifier is sometimes just a
number (for example, 128), and does not necessarily tell you what
kind of item you are translating. Often, you can deduce that you are
working with a dialog box, but nothing as specific as the Calendar or
Calculator.
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4.2 Translating Service Pack Resources

This section provides an overview of service pack resource translation and discusses
how to translate service pack resources.

4.2.1 Understanding Service Pack Resource Translation

Resource Text Translation (RTT) comes from DLLs and Java files that are part of
ClearCase and the service pack trees. This information is not part of standard pristine
data sources or tables. The translating service pack resources process includes an
extract and update for the resources in the DLLs and Java files.

The Resource Life Cycle is associated with service packs and not a major release.

4.2.2 Translating Service Pack Resources

You run several different processes when you translate service packs. the programs
could be in a different location (Rtt.exe, for example). These steps provide high-level
guidance so that you do not miss any of the steps in the process.

The mastering group should perform some of these steps, and the translation group
should perform others. These steps indicate which group should perform which task.

To translate service pack resources:

1. The mastering group extracts the RTT files into a source Delta environment using
the Rtt.exe.

2. The mastering group runs the Delta Process using the Translation Delta Process
program (R79800) for each compare environment for each tier.

3. The mastering group runs the Check Delete Status program (R79802) to update
orphaned records in the status stable.

The process runs all languages simultaneously for each compare environment.

4. Either the translation group or the mastering group rebuilds the keys by language
using either the Delta Purge and Rebuild Process program (R79801) or the
Resource Text Translation program (P79201).

Note: Any translator can perform this step. Use the Rebuild Key
option from the Form menu of the Resource Text Translation program
(P79201).

5. The translation group translates the source items using the Resource Text
Translation program (P79201).

Translate each language.

6. The mastering group runs the Delta Purge and Rebuild Process program (R79801)
to purge the records that are set to a status of 99 (Purge from System).

Run this process once for each language.
7. The mastering group builds the package (.d11 and . jar files) using the Rtt.exe.
Run this process once for each language.

8. The translation group checks the package (.d11 and . jar files) using Visual C++,
JD Edwards EnterpriseOne Standalone, and language install on a web server for
Java and HTML.
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Check the package for each language.

Note: Everything done by language needs to use the appropriate
setup for the language and code pages.

4.3 Translating Resource Text

This section provides an overview of resource text translation and discusses how to
translate resource text.

4.3.1 Understanding Resource Text Translation

Resource Text Translation (R1T) finds and displays items by matching the search
criteria that you enter in the fields or on the Query by Example (QBE) line. The
information that you enter in these fields remains until you change it. The files that
appear contain the items that you will translate.

4.3.2 Translating Resource Text

To translate resource text:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F7920: Resource Text Translations (RTT).

On Work With Resource Text Translation, complete the Selected File Name, Status,
and Language fields, and click Find.

Note: The F7920: Resource Text Translations (RTT) tool retrieves the
resource items that match the search criteria and displays them in the
detail area.

Any language that you search on that is not specified in the user
profile is read-only.

If you leave any of the fields blank, the system uses the default value
of * (asterisk), which equals a search for all items.

On Work With Resource Text Translation, select a record in the detail area and then
click Select.

On Resource Text Translation, click the item in the menu tree that you want to
review or translate.

Enter the translation in the Target window, and then click OK to save it.

You must enter a translation. The system does not save blank records.

Translating Resource Text 4-3



Translating Resource Text

4-4 JD Edwards EnterpriseOne Tools Translation Tools Guide



O

Translating the Data Dictionary

This chapter contains the following topics:

Understanding Data Dictionary Translation
Translating Alpha, Row, and Column Descriptions
Translating Glossary Entries

Copying Existing Items

5.1 Understanding Data Dictionary Translation

This section discusses:

Data dictionary items.

The data dictionary translation process.

Data dictionary items and the Form Design Aid (FDA) translation tool.
The SAME shortcut.

Data dictionary translation tools.

Data dictionary item navigation.

Data dictionary space constraints.

5.1.1 Data Dictionary Items

Data dictionary items include check boxes, radio buttons, text fields, grid items, and
help text that appear throughout Oracle's JD Edwards EnterpriseOne software. The
data dictionary stores the descriptions for these items. Each data dictionary item
contains at least one of the these components:

= Alias: an alpha code given to a data dictionary item.

= Alpha description: the title that appears in the help text in the software when you
press F1.

= Row description: the text that describes form controls.
s Column description: the text that describes grid columns.

»  Glossary: the full description text in paragraph form when you press F1.

5.1.2 The Data Dictionary Translation Process

Translating a data dictionary item is an iterative six-step process, as described here:
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1. Select the data dictionary item that you want to translate.

2. Review both the data item components for context and the suggestions for
appropriateness.

3. Enter the translation manually or copy existing translations.
4. Check the spelling.
5. Review space constraints.
6. Save the translation and start the process over again.
JD Edwards data dictionary translation tools use many of the same processes
repeatedly.
See Also:

»  Chapter 14, "Understanding Jargon and Overrides".

5.1.3 Data Dictionary ltems and the FDA Translation Tool

The data dictionary translations that you enter are the translations for their
corresponding forms. Therefore, when you access a form in the FDA Translation Tool
(P797501), the data dictionary translation appears as the field description unless the
item has an override. The status for the form items in the FDA Translation Tool
remains at a status of 20 (Untranslated) until you save the translation. When you save
the translation, the item moves to a status of 15 (FDA/RDA DD Default).

When you edit a data dictionary translation, FDA items that are not overridden by a
language are set to a status of 25 (Edit (Review)). You can view the list of
language-overridden and non-overridden forms in the English Non-Overridden
Forms box. When you access the affected forms in the Form Design Aid (FDA)
Translation Tool, the edited translation appears in the Translation field.

5.1.4 The *SAME Shortcut

When you are translating an alpha description that has jargon applied, two fields
appear for both the Source and Target columns: Alpha - Base and Alpha Description. If
the translation of the base description is correct for the alpha description, you can
reuse the base description by entering *SAME in the Translation field.

5.1.5 Data Dictionary Translation Tools

You use three data dictionary language translation tools to translate data dictionary
items:

= F00165 (GT92002): Data Dictionary (DD) Glossaries.

s F9202: Data Dictionary (DD) Row / Column.

s F9203: Data Dictionary (DD) Alpha.

You access all of these tools through the Translation Applications menu (GH791).

5.1.6 Data Dictionary ltem Navigation

When you access any of the data dictionary translation tools, the data items for the
system and status that you specified appear. You can select an item by double-clicking
it or by choosing the item in the detail area and clicking Select.
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If you are looking for a specific item, you can use the Find button to search by alias.
You also can search for a specific item from a different system. To display all items in
another system, specify a new system in the Product Code field. You can view and edit
translation items in a product code that is not specified in the user profile.

The Find/Browse (Work With...) form enables you to search for data dictionary items
that require translation or review. You can search for data items by product code,
language, status, or all three. When you select an item on one of these forms, you
access the Data Dictionary Translations form.

5.1.7 Data Dictionary Space Constraints

A fixed amount of space is available for most data dictionary items. Alpha and row
descriptions are allotted 40 characters, and column descriptions are allotted 20
characters for the top translation field and 20 characters for the bottom translation
field.

Although the translation might fit within the space allotted in the data dictionary
translation tool, it might not fit in the space allotted in the Form Design Aid (FDA)
Translation Tool. In other words, not all forms allow 40 characters for controls.

A data dictionary item can be used on many forms, and those forms might allow
different amounts of space. The data dictionary translation tool finds the form that
allows the least amount of space, and displays the amount so that you can enter a
translation that will fit in all forms. If you exceed the space available, a warning
message appears.

Note: To view a non-overridden form or a form with a translation
override, click the form name in the English Non-Overridden Forms
box.

5.2 Translating Alpha, Row, and Column Descriptions

This section provides an overview of alpha, row, and column descriptions and
discusses how to edit data dictionary alpha, row, and column entries.

5.2.1 Understanding Alpha, Row, and Column Descriptions

The Data Dictionary Language Translation program (P799201) treats alpha
descriptions as individual items with their own status codes. When you translate, you
must select to work with either alpha, or row and column descriptions. Because most
alpha descriptions have related row and column descriptions, you should translate
alpha descriptions first.

Row and column descriptions make up one item. One status code applies to both
descriptions.

See Also:

s Understanding JD Edwards Translation Tools.

5.2.2 Editing Data Dictionary Alpha, Row, and Column Entries

You can edit Alpha and Row, and Column Entries dynamically. Editing them
dynamically enables you greater consistency when translating the data dictionary.

To edit data dictionary alpha or row, and column entries:
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1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then select either F9202: Data Dictionary (DD) Row / Column or F9203: Data
Dictionary (DD) Alpha.

2. On the Fix/Inspect (Work With...) form, locate the records that you want to
translate.

3. Select an item in the detail area and then click Select.
4. On Data Dictionary Translation, select the Translation tab.
5. Complete these target fields as necessary:
- Alpha Description
Enter an alpha description translation.
— Row Description
Enter a row description translation.
- Column Title
Enter a column title translation for Column 1 or Column 2 or both.

6. Click OK.

Note: ]D Edwards Translation Tools accept a blank translation field
only for Column Title 2 fields. If you are unsure about a translation,
change the status of the item to 25 (Edit/Review) and review it later.

5.3 Translating Glossary Entries
This section provides an overview of glossary translation and discusses how to:
» Translate glossary entries.
= Filter glossaries.
= Export glossaries.
= Translate glossaries in a translation memory tool.
= Import glossaries.

= Validate glossaries.

5.3.1 Understanding Glossary Translation

The glossary is the help text that you see when you press F1. As you translate items,
review the glossary entry to understand the context in which the data dictionary item
is used. If you notice a mistake in the translated glossary entry, you can edit it on the
Glossary tab.

Note: JD Edwards Translation Tools do not have a translation
memory.

5.3.1.1 File Naming Conventions for Exported Glossaries

On export, an XML file is saved to the file path specified in the File Path (Folder) field.
The file name is created using the primary filters that are located on the Filter tab. The
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system uses these primary filters to build the export file naming convention. The File
Path (Folder) field is limited to 30 characters.

Language_ TranslationStatus_SystemCode_GlossaryGroup_ DataltemFrom_
DataltemTo .XML

This example illustrates a typical file name:

S 20 01_D_A_LXML

S = Spanish

_20 = Untranslated

_01 = Address Book

_D = Glossary Group

_A = Data Items from A

_L=DataltemstoL

Data items can be used in a range, such as A to L, or be specific, such as AN8 or LNGP.

In the file name on the XML tab, the wildcards (*) that you might have used on the
Filter tab are substituted for a plus sign (+). A plus sign should work across all ASCII
code pages. Additionally, the system uses a default path naming convention in the file
name field. You should not change this naming convention.

5.3.2 Translating Glossary Entries
To translate glossary entries:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F00165 (GT92002): Data Dictionary (DD) Glossaries.

2. On the Work With Glossary Data Dictionary Translation form, complete these
fields and click Find.

— Product Code

- Glossary

— Status

- Skip from

- Skipto

- Language

Select a data item in the detail area and then click Select.
On Data Dictionary Translation, select the Glossary tab.

Enter the translation in the lower media object window.

o a ~ w

Click OK to save the changes.

The data item moves to the next workflow status. When you click OK, JD Edwards
Translation Tools saves the changes and updates the status. The new glossary item
will appear on the Translation tab the next time the Delta Process is run.
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5.3.3 Filtering Glossaries

You can filter the glossaries to select exactly the ones that you want to export. You
might want to filter glossaries to control the size of the output file.

To filter glossaries:

1.

3.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F00165: (GT92002) Data Dictionary (DD) Glossaries.

On the Work With Glossary Data Dictionary Translation form, select the Filter tab,
complete these fields, and then click Find:

— Product Code

- Glossary Group
— Status

- Skip From

- SkipTo

- Language

The user overrides save the values that you enter. These values reappear the
next time that you log in.

If you are using TRADOS, you should limit the size of the export to 0.5 MB.
TRADOS can receive only files smaller than 0.5 MB in size. If the file is larger
than 0.5 MB, TRADOS displays an error. You will have to experiment to
determine how many records equal 0.5 MB because glossary records vary in
size.

Select the XML tab.

You now can export glossaries from JD Edwards EnterpriseOne software.

5.3.4 Exporting Glossaries

After you complete the steps to filter glossaries, you must export the glossary data
from JD Edwards EnterpriseOne software.

To export glossaries:

1.
2.

On the Work With Glossary Data Dictionary Translation form, select the XML tab.
Ensure that a file path is specified as a root directory in the File Path (Folder) field.

A literal folder must be set up to handle the export or import (C:\ is the default
folder). You must have the same file path set up in the root directory as is specified
here. The File Path (Folder) field is limited to 30 characters.

Ensure that you have a file name in the File Name field.
Select one of these options:
- Source
Source text is exported.
— Target
Target text is exported.

— Remove Hard Return
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Important: Selecting the Remove Hard Return option will remove all
hard returns from the glossary records. The import process does not
reinsert the hard returns.

5. After you have entered the appropriate filters, specified the File Path (Folder)
field, and determined the text option, from the Form menu, select Export.

An XML file has been created.

6. You can now use the translation memory tool to translate glossaries.

5.3.5 Translating Glossaries in a Translation Memory Tool

JD Edwards Translation Tools enable you to filter glossary information, including the
alpha description, and create an XML file.

An example of a translation memory tool is TRADOS. The TRADOS Tag Editor
enables you to use translation memory, including the TRADOS Translators
Workbench. After translation is complete, the Translation Memory Editor saves
translated data in an XML file. JD Edwards Translation Tools then import the XML file
into the correct environment and code page in JD Edwards EnterpriseOne software
and include preview functionality, which enables translators to validate the data.

To translate glossaries in TRADOS:
1. Complete the steps to export glossaries:
2. From the Form menu, select TM Editor.

3. Either the TagEditor for TRADOS will open or the TM Editor listed in the
processing options will open.

4. Edit the glossaries using the translation memory functions.
5. Select File Save as Target and replace the XML file.

You now can import glossaries into JD Edwards EnterpriseOne software.

5.3.6 Importing Glossaries

You import the glossaries into JD Edwards EnterpriseOne software similar to the way
that you exported them. You do this after you complete the steps to translate
glossaries.

To import glossaries:
1. Ensure that you have saved the data in the XML file.

JD Edwards EnterpriseOne software uses the primary filters to build the import
file naming convention. Ensure that the file name is exactly the same as when you
exported it.

2. From the Form menu, select Import.

3. The status records are updated to Translation Memory at status 35 (Translation
Memory).

You now can validate the glossaries.
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5.3.7 Validating Glossaries

You can validate the glossaries after you import them back into JD Edwards
EnterpriseOne software. You do this after you complete the steps to import glossaries.

To validate glossaries in JD Edwards EnterpriseOne software:

1. On the Work With Glossary Data Dictionary Translation form, select a record in
the detail area, and then click Select.

2. On the Data Dictionary Translation form, select the Glossary tab, and then verify
that the glossary text was imported correctly.

3. From the Form menu, select Target Preview, and then verify the format of the F1
help.

4. Validate all glossaries that you imported again.

5.4 Copying Existing Items
To copy existing items:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then select either F9202: Data Dictionary (DD) Row / Column or F9203: Data
Dictionary (DD) Alpha.

2. On the Fix/Inspect (Work With...) form, locate the records that you want to
translate.

3. Select an item in the detail area, and then click Select.
4. On the Data Dictionary Translation form, select the Translation tab.
5. On the Form menu, select one of these options:
- Copy Source
Copies the information from the source field to the target field.
- Copy Alpha

Copies the information for the alpha description into the row and column
target field.

- Copy Row

Copies the information for the row description into the target field for the
column description.

- Copy Previous
Copies the information from the last saved translation into the target field.

6. Click OK to save the changes.
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Translating Processing Options

This chapter contains the following topics:

s Understanding Processing Option Translation
= Displaying Processing Option Items

s Translating Processing Options

= Using Source and Target Preview

6.1 Understanding Processing Option Translation
This section discusses:
= The processing option translation process.
»  The processing option translation tool interface.

= Processing option tool features.

6.1.1 The Processing Option Translation Process

Processing options (POs) enable users to control how an interactive or batch
application manages data. Users select processing options to configure the way that
applications and reports look and function. Within Oracle's JD Edwards EnterpriseOne
software, users work with forms to access, view, and enter information. These forms
are made up of many items, such as radio buttons, text fields, check boxes, and data
dictionary-based items.

To users, processing options appear as tabbed forms containing fields. Users use these
objects by entering information into these fields, selecting options from these
drop-down menus, clicking buttons, and so on.

When users place their cursor over the tab name, a definition of the tab appears. You
must translate both the tab name and its definition. In Processing Option Text
Translation, the tab name appears followed by each object that appears on a tab. Use
the PO Translation Tool to translate items from the source language into the target
language.

You translate all processing options using the Processing Options Translation Tool. In
addition to translating items, you can retrieve and use existing translations, use spell
check, change the status of an item, save translated items, and view glossary
definitions.

Because processing options are written in paragraph form and can contain hundreds
of lines of information, they are typically one of the most time-consuming components
to translate.
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6.1.2 The Processing Option Translation Tool Interface

The Processing Option Text Translation form contains three tabs: View, Audit, and
Glossary. Use these tabs to complete all translation requirements, including changing
translation status, viewing item history, and comparing with the glossary content.

6.1.2.1 Processing Option View Tab

The View tab displays a consolidated view of information for each PO. Use it to
perform actual translations, change item status, review translations, view object
information, and so on.

The View tab provides the status and description followed by the translation of the
description for the selected processing option. You can view the source, translation
text, or both depending on which of these options you select:

s Source
s Target
] BOth

6.1.2.2 Processing Option Audit

The Audit tab displays historical and statistical information for each PO item. Use it to
view when the item was last translated, how many items are not translated, who last
translated the item, and so on.

6.1.2.3 Processing Option Glossary

The Glossary tab contains glossary information (including the Data Item Help ID
Override) that is assigned to a data dictionary item. Use it to make contextual
comparisons in order to more accurately translate an item.

6.1.3 Processing Option Tool Features

The Processing Option Text Language Translation tool has many features to assist you.

6.1.3.1 Get Specs

From the Form menu, you can select Get Specs. This selection downloads the latest
specifications for forms and processing options for the current release. You use this
feature when you find discrepancies between the software and preview of the forms
and POs.

6.1.3.2 Top

From the Form menu, you can select Top to bring you back to the first item of the list
in the current template that you are translating. You use this feature when translating
processing option templates that are very long.

6.1.3.3 Data Dictionary Glossary Exit

From the Form menu, you can access the Data Dictionary translation tool. You can use
the Data Dictionary glossary selection to update or add a data dictionary translation.

6.2 Displaying Processing Option ltems

The F98306: Processing Options (PO) Translation Tool enables you to search for and
display PO items by product code, language, status, object name, or any combination
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of these criteria in the detail area. Searching for items using these criteria enables you
to specify the PO items to display.

To display processing option items:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F98306: Processing Options (PO).

2.  On the Work With Processing Option Text Translation form, complete any of the
these fields, and click Find:

— Product Code
- Language
— Status

Select this option to see all the details for the items in the detail area. To return
to a summarized view, clear the option.

3. In the detail area, select the item that you want to translate and click Select.
4. Translate the item.

5. Click OK.

6.3 Translating Processing Options

You can enter translations manually, copy the source language, or use a previous
translation. This section provides an overview of processing option space constraints
and discusses how to copy description data.

6.3.1 Understanding Processing Option Space Constraints

For each item in the Source Tab Page or the fields in the Source Tab Page, a fixed
amount of space (40 bytes) is available for the target text. Because translations usually
require more space in most target languages than they do in source languages, you
might have to abbreviate the translations. As you type a translation, the Processing
Options Translation Tool keeps track of the number of bytes that are used. When you
exceed the 40 bytes allotted, the cursor stops, preventing you from entering any more
characters. When this happens, either abbreviate the translation or use another term.

See Also:

s Understanding JD Edwards Translation Tools.

6.3.2 Copying Description Data

If no translation exists for the source term, you can use the Copy Source option to copy
the source text term into the target text field. This copy capability helps you maintain
the formatting of the source text.

To copy description data:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F98306: Processing Options (PO).

2.  On the Work With Processing Option Text Translation form, locate the processing
option records that you want to translate.

3. Select an item in the detail area, and click Select.
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The Processing Option Text Translation form appears, displaying the status, source
description, and target description in the common area.

Note: Tabs control the processing of the associated items.

To see the processing option in context, you can select either Source
Preview or Target Preview from the Form menu.

Double-click the Media Object Column in the detail area to select the desired item
tab for translation.

A green check mark in the Media Object Column identifies the item as translated.
A red X in the Media Object Column identifies the item as untranslated.

The data for the selected tab appears in the common area with the data initially
displayed in the source and target (Tab-Page), each with two short data fields.

Translate the source text on line 1.

From the Form menu, select Copy Tab.

The term is copied from line 1 to line 2 (top to bottom).
Click OK to save the translation.

When you click OK, the system saves the translation, updates the status, and
displays the next item of the chosen status in the Source data field.

When you click Save, the system saves the translation and updates the status, but
does not move on to the next item in the list.

6.4 Using Source and Target Preview

Oracle's JD Edwards EnterpriseOne Translation Tools offer many features to help you
further refine the data, structure, and physical appearance of the translations. These
features help you refine the translations:

Source Preview.

This feature enables you to view source objects as they appear in the software. Use
the source preview to review software objects in the source language for content
and format as you make translation choices.

Target Preview.

This feature enables you to view target objects as they will appear translated in the
software. Use the target preview to review the software objects in the target
language for content and format as you make translation choices.

These JD Edwards Translation Tools have the Source Preview and Target Preview
features:

F79750: Form Design Aid (FDA).
F79760: Report Design Aid (RDA).
F9203: Data Dictionary (DD) Alpha.
F98306: Processing Options (PO).

To use source or target preview:
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From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then select any translation tool with source or target preview.

Select an item in the detail area.
From the Form menu, select one of these selections:
— Source Preview

— Target Preview
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Translating Forms

This chapter contains the following topics:
= Understanding Form Translation
s Translating Forms

= Using Overrides

7.1 Understanding Form Translation
This section discusses:
= Form translation.
s The form translation process.
= Single line items.

s The Form Design Aid (FDA) tool.

7.1.1 Form Translation

Within Oracle's JD Edwards EnterpriseOne software, users work with forms to access,
view, change, and enter information. Forms consist of many items, such as radio
buttons, text fields, check boxes, and column headings that are based on data
dictionary items.

Forms can be accessed from multiple JD Edwards EnterpriseOne programs and
menus. The Form Name begins with the letter W, followed by the application code and
a letter. For example, in the Form Name W0101A, W indicates that it is a form, 0101
indicates that the form belongs to program P0101, and A indicates that it is form A
within the application. When you translate forms, you translate all the single line
items for that form, such as form title, controls, menu hyper controls, grids items, and
SO on.

You use the F79750: Form Design Aid (FDA) translation tool to translate form items
from the source language into the target language. (Only applications that are created
using JD Edwards application Form Design Aid are translated using the F79750: Form
Design Aid (FDA) translation tool.) The Form Design Aid (FDA) translation tool:

= Displays form items in the context that they appear in JD Edwards EnterpriseOne
software

= Displays related data dictionary items when available
= Contains reference features

»  Tracks productivity

Translating Forms  7-1



Understanding Form Translation

7.1.2 The Form Translation Process

Translating form items requires more than just looking at a term and entering a
translation. The terminology you use depends greatly on the context in which the term

is used.

For example, the word job might refer to an employee's position in a human resources
context, but might refer to batch processing in an accounting context. So the
translation you use in one system might not be appropriate in another.

This concept is especially critical when translating forms because an individual form
might be used in more than one system. In these instances, you must ensure that the
translation is appropriate in context for both systems.

As you translate forms, you must pay attention to overrides, context, and proposed

translations.

See Also:

»  Chapter 14, "Understanding Jargon and Overrides".

7.1.3 Single Line Items

Single line items are the individual items that make up a form. These items, such as
controls and grids, relate to a data dictionary item. The base data dictionary
description is used for these items unless an override is applied. You can translate

these single line items within a form:

Single Line ltem

Explanation

Title

In JD Edwards Translation Tools, the form title
appears in the upper left hand corner of JD
Edwards EnterpriseOne software forms and
beneath the Form folder in the menu tree of
the Form Design Aid Text form.

Control

Controls are the text fields, check boxes, static
text, and radio buttons that appear in JD
Edwards forms. Many controls correspond to
a data dictionary item.

Menu Hyper Controls

In JD Edwards EnterpriseOne software, menu
hyper controls access applications and forms.
They are the options available from the
drop-down menus at the top of JD Edwards
forms as well as from the Exit bar.

Tabs

In JD Edwards forms, tabs act as separators
for groups of controls. Users click the tabs to
display a new group of controls. Tabs appear
in the menu trees (as for controls), but are
labeled as tabs in the translation area when
you select them.

Grid Items

Grid items are row and column headers for
the table. Grid items correspond to the column
description for a data dictionary item. On a
form, they are the column titles in the detail
area.
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Single Line ltem Explanation

Text Variables In JD Edwards EnterpriseOne software,
multiple line items are used for text strings
and runtime text substitution. Text variables
are stored as strings and can be used as an
alternative to hard coding text strings in
assignments. Developers use text variables
instead of hard-coded text because text
variables are easier to maintain. You translate
text variables; you do not translate hard-coded
text.

7.1.4 The Form Design Aid (FDA) Translation Tool

The F79750: Form Design Aid (FDA) Tool is designed to provide contextual translation.
The tool uses tree structures on different tabs to define the context. You use the tabs on
this form as well as the features from the Form menu to review and translate FDA
items.

7.1.4.1 Form Design Aid View

The View tab displays the individual items within a form. The translation functions
that appear in the common area at the bottom of the form do not change. You can
display forms, select the items you want to translate, enter translations, change the
status of an item, and perform various other tasks related to translating items. When
you have selected a form title, a green arrow displays next to the Target data field to
assist you in determining where you are in the list.

7.1.4.2 Form Design Aid Audit

The Audit tab displays the statistics for items contained in the form. You cannot enter
or change any of the displayed items. The data field information in the common area
remains the same as on the original View tab.

7.1.4.3 Form Design Aid Task

The Tasks tab enables you to view tasks from within the F79750: Form Design Aid
(FDA) application. You translate tasks from the Task Language Translation program
(P799000).

7.1.4.4 Form Design Aid Data Dictionary

The Data Dictionary tab enables you to view the Alpha, Row, Column, or FDA text
that appears on the form within the F79750: Form Design Aid (FDA) application. You
translate data dictionary items from the Data Dictionary Language Translation
program (P799201). Double-click a data dictionary item in the tree to access the Data
Dictionary Language Translation program.

7.1.4.5 Form Design Aid Glossary

The Glossary tab enables you to view a glossary for a data item. You can view the
source glossary on this tab, but you cannot revise the glossaries on this tab. You
translate data dictionary items and glossaries from the Data Dictionary Language
Translation program (P799201). Double-click a data dictionary item in the tree on the
Data Dictionary tab to access the Data Dictionary Language Translation program.
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7.1.4.6 Form Design Aid Processing Options

The Processing Option tab enables you to view processing options associated with a
program. You translate processing option items from the Processing Option Text
Translation program (P7998306). Double-click an item in the menu tree to access the
Processing Option Text Translation program.

7.2 Translating Forms
This section provides an overview of form space constraints and discusses how to:
s Translate tabs, controls, and titles.
» Translate menu hyper items.

» Translate grid items.

7.2.1 Understanding Form Space Constraints

Oracle's JD Edwards EnterpriseOne grid items, titles, and certain controls (radio
buttons, text boxes, and static text) are measured in pixels, while menu hyper items,
tabs, and the remaining controls are measured in characters. Because terms might take
up more space in the Target language than in Source language, it can be difficult to
meet space constraints, and you may have to abbreviate the translations.

You can view the space available and space used in the Text Information area of the
Form Design Aid Text form. As you tab out of a field, the system calculates the space
used. If you exceed the space available, the cursor stops, and you must shorten the
translation before you can save it.

See Also:

»  Chapter 14, "Understanding Jargon and Overrides".

7.2.2 Translating Tabs, Controls, and Titles

Tabs, controls, and titles are all translated in the same way. When you select one of
these items, the Source term appears in the Source field, and you enter the translation
in the Target field.

To translate tabs, controls, and titles:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F79750: Form Design Aid (FDA).

2.  On Work with Form Design Aid Text, complete these fields and click Find:
- Product Code
- Status
- Language
—  Status Details

This option enables you to see all of the details for the items in the detail area.
To return to a summarized view, turn this option off.

3. C(Click an item in the detail area and click Select.

4. On Form Design Aid Text, click the View tab and then click an item in the menu
tree.
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5. Enter the translation in the Target data field.

6. Click OK to save the translation.

When you click OK, the system saves the translation, updates the status, and
displays the next item of the chosen status in the Source data field.

When you click Save, the system saves the translation and updates the status, but
does not move on to the next item in the list.

7.2.3 Translating Menu Hyper ltems

When translating menu hyper items, you must translate both the long and short text

descript

ions. Each menu hyper item also has a keyboard shortcut, or hot key, and, if a

menu hyper item is associated with the text descriptions, this key must be included in
the translation. This table describes the parts of a menu hyper item:

Menu Hyper ltem Component Description

Menu hyper items short text descriptions Short text descriptions are the abbreviated

menu options that access applications.

Menu hyper item long text descriptions Long descriptions provide an unabbreviated

description of menu hyper items.

Hot keys

Hot keys are the keyboard shortcuts used to
select menu options. Users can select a menu
option by pressing Alt + (hot key). A letter in
the menu option acts as the hot key and is
indicated by & (ampersand) preceding the
letter. For example, the menu hyper short
description File (&F) indicates that the hot key
for the File option is F.

Note: If you have the literal & (ampersand) in the translated text,
you must enter && (two ampersands) to represent the symbol. If you
do not enter && (two ampersands), the software represents the
translation as a hot key.

When you select a menu hyper item, both the menu hyper short and menu hyper long
text descriptions appear in the common area of the Form Design Aid Text form.

To translate menu hyper items:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,

and

then F79750: Form Design Aid (FDA).

2.  On Work with Form Design Aid Text, complete these fields and click Find:

3. Sele

Product Code
Status
Language
Status Details

This option enables you to see all the details for the items in the detail area. To
return to a summarized view, clear this option.

ct an item in the detail area and click Select.
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On Form Design Aid Text, select a menu hyper item in the menu tree.
Both the short and long text descriptions appear in the common area.
Type a translation for the menu hyper item short description.

Type a translation for the menu hyper item long description.

Click OK.

When you click OK, the system saves the translation, updates the status, and
displays the next item of the chosen status in the Source data field.

When you click Save, the system saves the translation and updates the status, but
does not move on to the next item in the list.

7.2.4 Translating Grid ltems

Grid items are the column headings that appear in the detail area of JD Edwards
forms. Each grid item can contain multiple words. Two lines are allocated to each grid
item (Column 1 and Column 2). When you select an item, two translation fields appear
in the common area.

When you select a grid item, the Space Used field displays the amount of space used
for both the top and bottom translation fields.

To translate grid items:

1.

o o k~ ©

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F79750: Form Design Aid (FDA).

On Work with Form Design Aid Text, complete these fields and click Find:
— Product Code

- Status

- Language

— Status Details

This option enables you to see all the details for the items in the detail area. To
return to a summarized view, clear this option.

Select an item in the detail area and click Select.
On the View tab, click a grid item in the menu tree.
Translate the item in the Target field.

Click OK.

When you select OK, the system saves the translation, updates the status, and
displays the next item of the chosen status in the Source data field.

When you select Save, the system saves the translation and updates the status, but
does not move on to the next item in the list.

7.3 Using Overrides

This section discusses how to:

Use overrides.

Remove overrides.
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7.3.1 Using Overrides

When an English override is applied to an item within an application, it means that a
developer overrode a data dictionary description and entered an alternate description.

When an item does not have an English override, the base data dictionary description
automatically appears in the Target field. Controls and grids within a form in an
application correspond to a data dictionary item. If development has not overridden
the text, you should assign the data item the DD Default (status 15 FDA/RDA DD
Default) when you translate.

When an English override is applied to an item, the Text Overridden check box in the
Text Information group is selected in the Form Design Aid Text form. In these cases, a
language override is also applied automatically. You cannot clear the Text Overridden
check box when the English description was overridden. The text must be translated
because the DD Default cannot be used. Use the Suggestions option to ensure
consistent terminology when translating overridden items.

Note: When you change a default value for a data dictionary item,
the change is made dynamically in every instance of the software.
Changes to overrides must be made to each individual instance.

7.3.2 Removing Overrides

If the base translation is not appropriate in the context of the application's form, you
have these options:

s Change the item to status 15 (FDA/RDA DD Default) to apply a language
override. The new translation you enter applies only to the item for that particular
application.

= Apply an override yourself. Use status 11 (Complete) to apply a language
override. The new translation you enter applies only to the item for that particular
application.

= Remove a language override by changing the status to 11 (Complete). When you
do this, JD Edwards Translation Tools display the data dictionary translation for
you to review and replace as necessary.
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Translating Reports

This chapter contains the following topics:
s Understanding Report Translation
s Translating Report Information

= Using Overrides

8.1 Understanding Report Translation
This section discusses:
= Report translation.
s The report translation process.
= Report versions.

»  The Report Design Aid (RDA) Translation Tool interface.

8.1.1 Report Translation

You create reports using Oracle's JD Edwards EnterpriseOne Report Design Aid (RDA)
Translation Tool. Reports are generally referred to as Universal Batch Engines (UBEs)
because they not only present data in report form, but they also can be used to create
batch programs that perform certain actions.

Reports are used to view trends, outcomes, and information from JD Edwards
applications. Reports can be accessed from multiple JD Edwards programs and menus.
Generally, a report name begins with the letter R and is followed by the application
name; there are exceptions, however.

Use the Report Design Aid (RDA) Translation Tool to translate interface items of JD
Edwards reports from the source language into the target language.

8.1.2 The Report Translation Process

You translate reports by selecting untranslated items within the assigned system. To
translate report items:

1. Display the first report in the list.
2. Translate these items:

- Report title

— Page headers
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- Page details

— Columns

Note: Section titles do not need to be translated.

3. Save the changes.

When you save a translation, the JD Edwards Translation Tool displays the next item
of the chosen status. Continue translating items until no untranslated items remain.

See Also:

s Chapter 14, "Understanding Jargon and Overrides".

8.1.3 Report Versions

Different versions of the same report often exist. The base report or template is marked
with a plus sign (+), and versions are usually named XJDE0001, XJDE0002, ZJDE0001,
and so on.

A version is a user-defined set of specifications. These specifications control how
applications and reports run. You use versions to group and save a set of user-defined
processing option values or data selection and sequencing options. Interactive versions
are associated with applications (usually as a task selection). Batch versions are
associated with batch jobs or reports. To run a batch process, you must select a version.

8.1.4 The Report Design Aid (RDA) Translation Tool Interface

The Report Design Aid (RDA) Translation Tool consists of these tabs: View, Audit,
Tasks, Data Dictionary, Glossary, and Processing Options.

8.1.4.1 Report Design Aid View Tab

On the View tab of the Report Design Aid Text form, you can display all of the items
for the selected report in a menu tree view. When you click an item in the tree, the
current source term, the target term, and the status appear in the data fields of the
common area.

8.1.4.2 Report Design Aid Audit Tab

The Audit tab displays the selected statistics for items that are contained in the report.
You cannot enter or change any of the displayed items. The information in the
common area remains the same as it appears on the View tab.

8.1.4.3 Report Design Aid Tasks Tab

The Task tab lists the selected report's tasks in a tree format for you to review. All of
the entries are derived from the database by the system and cannot be changed.

8.1.4.4 Report Design Aid Data Dictionary Tab

The Data Dictionary tab contains the selected report's data items and user-defined
codes (UDCs) in a menu tree view. You cannot enter or change any of the displayed
items.
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Note: You can access the data dictionary translation tools to edit data
dictionary and user-defined code items from the RDA tools by
double-clicking node from the data dictionary folder or by selecting
DD from the Form menu.

8.1.4.5 Report Design Aid Glossary Tab

The Glossary tab contains the selected data item's glossary text. The Glossary tab
enables you to view the glossary for the source and target language. You cannot edit
the glossary from this tab. To edit the glossary, select DD from the Form menu. In
addition, the data field information in the common area remains the same as it appears
in the View tab.

8.1.4.6 Report Design Aid Processing Options Tab

On the Processing Options tab, you can view all of the selected report's processing
options items for translation in the menu tree format.

Note: You can access the Processing Option text translation tool to
edit processing option text from the RDA tools by double-clicking a
node from the Processing Options folder.

8.2 Translating Report Information

When you translate reports, you translate all of the items for that report, such as the
report title, page headers, page details, and columns.

To translate report information:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F79760: Report Design Aid (RDA).

2. On the Work with Report Design Aid Text form, complete these fields and click
Find:

— Status
- Language
- (Optional) Program ID
This field is in the detail area.
3. Select an item in the detail area and click Select.

4. On the Report Design Aid Text form, select the View tab, and then click an item in
the menu tree.

5. Enter the translation.
6. Click OK to save the translation.

When you click OK, the system saves the translation, updates the status, and
displays the next item of the chosen status in the Source data field.

8.3 Using Overrides

This section discusses how to:
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s Use overrides.

s Remove overrides.

8.3.1 Using Overrides

An English override that is applied to an item within an application means that a
developer overrode a data dictionary description and entered an alternate description.

When an item does not have an English override, the base data dictionary description
automatically appears in the target field. Controls and grids within a form in an
application correspond to a data dictionary item. If development has not overridden
the text, you should assign the data item the DD Default (status 15 FDA/RDA DD
Default) when you translate.

When an English override is applied to an item, the Text Overridden check box in the
Text Information group is selected in the Form Design Aid Text form. In these cases, a
language override is also applied automatically. You cannot clear the Text Overridden
check box when the English description was overridden. The text must be translated
because the DD Default cannot be used. Use the Suggestions option to ensure
consistent terminology when translating overridden items.

Note: When you change a default value for a data dictionary item,
the change is made dynamically in every instance of the software.
Changes to overrides must be made to each individual instance.

8.3.2 Removing Overrides

If the base translation is not appropriate in the context of the application's form, you
have these options:

= Change the item to status 15 (FDA/RDA DD Default) to apply a language
override.

The new translation that you enter applies only to the item for that particular
application.

= Apply an override yourself.

Use status 11 (Complete) to apply a language override. The new translation that
you enter applies only to the item for that particular application.

= Remove a language override by changing the status to 11 (Complete). When you
do this, ]D Edwards Translation Tools display the data dictionary translation for
you to review and replace as necessary.
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Translating Solution Explorer Tasks

This chapter contains the following topics:
s Understanding Task Translation

» Translating Menu or Task Items

9.1 Understanding Task Translation
This section discusses:
s Task translation.
s The Solution Explorer task translation process.

s The Solution Explorer task translation tool.

9.1.1 Task Translation

Tasks are menu items and application names that appear in Oracle's JD Edwards
EnterpriseOne software. The Solution Explorer task translation tools display the menu
name, followed by each application that appears when users select the menu in
EnterpriseOne software.

You use these Solution Explorer tools to translate solution tasks:
= F9000: Solution Explorer Tasks.

= F9005: Solution Explorer Variant Tasks.

= F9006: Solution Explorer Variant Task Details.

9.1.2 The Solution Explorer Task Translation Process

To users, menus and tasks appear as lists, or trees, from which users select applications
in JD Edwards EnterpriseOne software. These trees are multitiered, and often contain
several levels of options. When you place the cursor over the menu or application
name, a definition appears. You must translate the name and its definition. In the
Solution Explorer Task translation tool, each tab name is followed by each object in a
menu tree.

9.1.3 The Solution Explorer Task Translation Tool

You translate all menus and task items using the Solution Explorer task translation
tool. In addition to translating items, you can retrieve and use existing translations,
check spelling, change the status of an item, save translated items, search for and
replace target text, and so forth.
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9.1.3.1 The Work With Task Translations Form

The entry point to the Solution Explorer task translation tool is the Work With Task
Translations form. Use this form to search for and select items that need to be
translated. You can search for items using a variety of search criteria, such as language,
product code, and translation status.

9.1.3.2 The Task Translation Form

After you have selected an item from the Work With Task Translations form, the Task
Translation form appears. This form contains two tabs: View and Audit. Use these tabs
to complete all translation requirements, including changing translation status and
viewing item history.

On the View tab, you can select an item to translate or edit by clicking in the menu
tree. When you select an item, the tool highlights the item and populates the source
and target fields with the associated text.

The View tab displays a consolidated view of information for each menu or task item.
Use this tab to perform actual translations, change item status, view object
information, and so on.

The Audit tab displays historical and statistical information for each menu or task
item. You can review audit information for a delta item to see who translated it last, its
source, and so on. You do not need to check this information as part of the daily
translation process. However, it is a vital part of troubleshooting a problem item
caused by the translation tools or the delta process.

You can also translate the item that is currently displayed on this form, although you
cannot translate additional items.

9.2 Translating Menu or Task ltems

The Solution Explorer task translation tools enable you to search for and display
menu and task items by various search criteria, including product code, language,
status, task, or any combination of these criteria. Searching for items using these
criteria enables you to specify the menu and task items that are displayed.

Note: The Solution Explorer task translation tools retrieve the task
items that match the search criteria and display them in the detail
area.

Any language that you search on that is not specified in the user
profile is read-only.

If you leave any of the fields blank, the system uses the default value
of * (asterisk), which equals a search for all items.

To translate menu or task items:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F9005: Solution Explorer Variant Tasks.

2. On the Work With Variant Description Translations form, complete any of these
fields and click Find:

—  Product Code
— Status
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- Task View ID

- Language

Select the item that you want to translate, and click Select.
The Variant Description Translation form appears.

Select an item from the menu tree.

Translate the item.

Click OK.
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Translating User Defined Codes

This chapter contains the following topics:

s Understanding User Defined Code Translation
»  Accessing Items to Translate

= Reviewing Glossary Information

»  Translating User Defined Code Items

10.1 Understanding User Defined Code Translation
This section discusses:
s User defined code translation.

s User defined code translation tools.

10.1.1 User Defined Code Translation

Within Oracle's JD Edwards EnterpriseOne forms, users must often enter information
into text fields. Many times, users can select the information from a list of items called
User Defined Codes (UDCs). UDCs are codes and descriptions in JD Edwards
EnterpriseOne software that provide users with an easy way to select a value from a
list. UDCs are stored in tables within JD Edwards EnterpriseOne software.

Each UDC contains a description of the option as well as a code for that option. Only
the descriptions must be translated; the codes remain the same in every language.

10.1.2 User Defined Code Translation Tools

User Defined Codes (UDCs) are stored in tables that contain at least one item and can
hold an unlimited number of items. The User Defined Code (UDC) translation tool
displays all items in a table at once in order for you to view them in context.

You translate all User Defined Codes (UDCs) from JD Edwards UDC translation tools.
In addition to translating items, you can retrieve and use existing translations, check
spelling, change the status of an item, save translated items, search for and replace
target text, and view glossary definitions.

You use two tools to translate UDCs. You select which tool to use based on what you
want to translate. The function of each tool is as follows:

= F0004: User Defined Code (UDC) Types

Use this tool if you are translating only UDC Types. UDC Types are the actual
code table titles.
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s F0005: User Defined Codes (UDC)

Use this tool if you are translating only the UDC Codes or want to see all
untranslated UDC items. This tool displays all the UDC Codes as well as the
associated UDC Types, regardless of their translation status.

Both of these tools function similarly. However, if you decide to start translating using
the FOO05: User Defined Codes (UDC) tool, you must use the F0004: User Defined
Code (UDC) Types tool to verify that you have translated all UDC Types. You must do
this because the UDC Code tool does not display any untranslated code types if no
untranslated UDC Codes exist. Both of the UDC translation tools consist of the Work
With User Defined Code Type Language Translation form and the User Defined Codes
Translation form.

10.1.2.1 Work With User Defined Code Type Language Translation Form and Work
With User Defined Code Language Translation Form

The entry points to the User Defined Code (UDC) Translation tool are either the Work
With User Defined Code Type Language Translation form or the Work With User
Defined Code Language Translation form. Use these forms to search for and select
items that you want to translate. You can search for items using various search criteria,
such as language, product code, translation status, and UDC types.

You use these four data fields to search for UDC items to translate:
s Product Code

= Language (L)

n  Status

s UDC Types

These data fields enable you to specify the limits to be used in selecting the items to be
translated. The most restrictive specification is a specific code in each data field; the
least restrictive specification is the wild card * (asterisk) in a data field.

10.1.2.2 User Defined Codes Translation Form

After you have chosen an item from the Work With User Defined Code Type Language
Translation form or the Work With User Defined Code Language Translation form, the
User Defined Codes Translation form appears. This form contains these tabs: View,
Glossary, and Audit. Use these tabs to complete all translation requirements, including
changing translation status, comparing glossary content, and viewing item history.

10.2 Accessing Items to Translate

You select items to translate from the View tab. The View tab displays a consolidated
view of information for each UDC item. The tree view displays all items according to
the item you selected on the "Work With?" form. The information that is displayed
depends on the display options you select. You can use the View tab to select text for
translation, perform actual translations, change item status, view object information,
and so forth.

To select an item from the tree:

1. From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F0005: User Defined Codes (UDC).
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On Work With User Defined Code Language Translation, complete these fields
and click Find:

— Product Code

- Status

- Language

- UDC Types

Click the item in the detail area that you want to translate, and click Select.

The User Defined Codes Translation form appears with the item you chose
displayed in the Tree view.

In the menu tree, click the item you want to review or translate.
When you select an item, the system populates these fields:
- UDC Type
- UDC Code
- Source
The Source fields always populate with the source text.
— Target

The Target fields only populate when a translation exists.

10.3 Reviewing Glossary Information

UDCs can be associated with data items. The Glossary tab contains information that
describes that data dictionary item.

To review glossary information for UDCs:

1.

o o & W

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F0005: User Defined Codes (UDC).

On Work With User Defined Code Language Translation, locate the user defined
code records that you want to translate.

Select an item in the detail area and click Select.

Select an item from the tree menu.

On User Defined Codes Translation, select an item and click the Glossary tab.
Review the glossary.

The Glossary tab form contains information assigned to a data dictionary item.
Use it to make contextual comparisons in order to accurately translate an item.
You can translate the item currently displayed on this form, although you cannot
translate additional items. You translate the glossary using the Data Dictionary
Language Translation program (P799201).

10.4 Translating User Defined Code ltems

You have three options when translating user defined code items: you can enter
translations manually, copy the source item, or use the suggestion process. This section
provides an overview of space constraints and discusses how to:

Translating User Defined Codes 10-3



Translating User Defined Code Items

Enter translations manually.

Copy the source item.

10.4.1 Understanding Space Constraints

A fixed amount of space is available for the translated text of each item. Because
translated text usually requires more space for most target languages, you might have
to abbreviate the translations.

10.4.2 Entering Translations Manually

To enter a translation manually:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F0005: User Defined Codes (UDC).

On Work With User Defined Code Language Translation, locate the user defined
code records that you want to translate.

Select an item and click Select.

The User Defined Codes Translation form appears, displaying the source term in
the Source field.

In the Target field, enter the translated text.
Click OK.

When you click OK, JD Edwards translation tools saves the translation and
updates the status. You have to click Next to move to the next untranslated item.

10.4.3 Copying the Source ltem

To copy the source item:

1.

From the Translation Applications menu (GH791), select either Senior Translations
or Junior Translations, depending on whether you are a senior or junior translator,
and then F0005: User Defined Codes (UDC).

On Work With User Defined Code Language Translation, locate the user defined
code records that you want to translate.

Select an item in the detail area, and then click Select.

The User Defined Codes Translation form appears, displaying the source item in
the Source field.

Select a record in the menu tree.
On the toolbar of the form, click Form and then click the Copy Source option.
The source item appears in the Target field.

Click OK to save the translation.
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Translating Across Multiple Releases or
Environments

This chapter contains the following topics:
s Understanding Translation for Multiple Releases

= Matching Criteria for Updates and Audits in the Multiple Release Exact Match
Program (P7903)

11.1 Understanding Translation for Multiple Releases

You might have to translate more than one release at a time if you translated in these
situations:

= Ina prior release and the translations need to be matched in a current release.
= In the current release and you want to leverage those translations again.
= In the current release and the translations need to be matched in a prior release.

The Multiple Release Exact Match program (P7903) uses source text to locate target
text with the same text strings. Using the Multiple Release Exact Match program
across multiple releases or environments has these benefits:

= Ensures no disconnect between source and target text.
= Provides cost-effective budgeting of language assets.
= Provides consistent terminology.

= Eliminates production time for matching text.

= Accelerates the quality assurance process.

11.2 Matching Criteria for Updates and Audits in the Multiple Release
Exact Match Program (P7903)

This section provides an overview of matching criteria and discusses how to translate
across multiple releases or environments.

11.2.1 Understanding Matching Criteria

The Multiple Release Exact Match program (P7903) requires specific matching criteria
to update status, audit trail, and target translations. This table documents those criteria
and what the program does when it finds or does not find the specified criteria. The
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table also lists which source and target translation items it uses when matching them

for updates and for creating audit trails.

Criteria

Program Response

Reports and Forms (Data Dictionary
Verification and Status Update)

Data Dictionary Verification

The program verifies the source data
dictionary items against the Data Field
Display Text table (F9202) translations to
ensure that a data item name exists but no text
overrides exist.

Data Dictionary Status Update

If the program finds a data item name and no
text override, it updates the data dictionary
status to 15 (DD Default) when you run the
Multiple Release Exact Match program in final
mode.

Source

If the program detects blank source items, the
status of the item is updated to Skip (30) when
you run the Multiple Release Exact Match
program in final mode.

Primary Source Text

The program always matches the primary
source text against the text in the secondary
search environment.

Primary Source and Status

The primary source text and status must exist,
and the program always verifies against the
primary target.

Secondary Source

The secondary source, status, and target must
exist for an exact match.

Status Verification

The Multiple Release Exact Match program
verifies whether the:

= Primary pate translated is a null (does not
exist) date.

= Secondary date translated is greater than
or equal to the primary date translated.

= Primary target is null (does not exist) or
blank.

= Secondary complete status is equal to the
secondary search complete status.

Audit Trail

In the Primary Update Code Page
Environment, the Audit Trail information
updates the:

»  Last translator to XTRANS (use XTRANS
with Search/Replace & Review
Approved).

= Date translated to secondary last date
translated.

= User, PID, job, date, and time to the
current audit information.

»  Primary Selection Status (20) to Primary
Update Status (36)

11-2 JD Edwards EnterpriseOne Tools Translation Tools Guide



Matching Criteria for Updates and Audits in the Multiple Release Exact Match Program (P7903)

11.2.2 Translating Across Multiple Releases or Environments

You must be a senior translator to run the Multiple Release Exact Match program

(P7903).

To translate across multiple releases or environments:

1.

From the Translation Applications menu (GH791), select Exact Match Quality
Assurance, and then Translation Tools.

On the EnterpriseOne Translation Tools form, from the Form menu, select Exact
Match.

Complete the criteria in these categories:

Language

You can change languages to submit more than one language.
Mode

You can run the process in Preliminary or Final mode.
Preliminary

The system does not update records. It only reports the total number of
records.

Final

The system updates records to the primary compare and code page
environments.

Note: You should run the Exact Match process in Preliminary mode
first. Preliminary mode enables you to verify the record totals.

Selection Filter
Primary Product Code

You use the primary product code in conjunction with the status selection in
the primary compare environment to define a record set.

Note: You should repeat the process for each individual product
code. If you do not enter a value in the Primary Product Code field,
the system searches all product codes for matching records.

Status
Primary Selection Status

The record status that the system selects from primary environment. This
value is typically 20 (Untranslated).

Secondary Complete Status

The record status that the system matches against the selection status in the
secondary environment. This value is typically 11 (Complete).

Primary Update Status

The record status that the system uses to update records in the primary
environment. This value is typically 36 (Exact Match).
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- Primary Skip Status

The record status that the system uses to update blank records in the primary
environment. This value is typically 30 (Skip).

- Compare Environments
— Primary Update

The compare environment that the system uses to select and update matching
records that it finds from the secondary environment.

- Secondary Search

The compare environment that the system uses to verify the secondary
complete status and the source text of the match type.

— Code Page Environments
— Primary Update

In Final mode, the code page environment from which the system updates the
secondary code page environment after a match is found.

- Secondary Search

Once the match is found the secondary compare environment, the code page
data that the system uses to update the primary environment.

- Match Type
- None
No match is required.
- Source and Key
The source and the primary key of each table must match.
- Source and Product Code
The source term and product code must match.
- Source

Same term (Default) must match but in any product code. It does not have to
be the product code that you specified in the Primary Product Code field.

4. In the detail area, select the tables to include in the exact match process.
From the Form menu, select one of these options:
- Yes
Include all tables in the exact match process.
- No

Exclude all tables from the exact match process. This selection clears all tables
from the process so that you can select only those that you want.

Alternatively, you can include or exclude tables from the exact match process
by double-clicking a cell in the Include column and typing one of these values:

-1
Include the table in the exact match process.
- 0

Exclude the table in the exact match process.
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5. From the Form menu, select Submit.
Alternatively, you can click the Submit button on the header of the form.

Clicking Submit runs the Multiple Release Exact Match batch process (R79850) and
produces a report.

After you run the Exact Match process in Final mode, you should review and approve
the results.
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Quick Reference for Product Codes

This chapter contains the following topics:
s Understanding JD Edwards EnterpriseOne Product Codes
s Product Codes

12.1 Understanding JD Edwards EnterpriseOne Product Codes

JD Edwards EnterpriseOne assigns each group of its software products to a system.
Each system contains forms, data files, reports, programs, and other objects that are
designed for a specific business need. Every software product within a system has a
product code. For complex business situations, you might use several systems to
achieve a comprehensive solution.

12.2 Product Codes

This table displays some of the product codes for JD Edwards verticals and their
systems. For an up-to-date and comprehensive list, see user defined code (98/SY).

Product Code Description

00 Foundation Environment

01 Address Book

02 Electronic Mail

03 Accounts Receivable

03B Enhanced Accounts Receivable

03C Issue Management System

0301 Credit Management

04 Accounts Payable

05 Time Accounting/HRM Base

05A JD Edwards HR & PR Foundation

05C JD Edwards HR & PR Foundation - Canadian
05T Time Entry

05U JD Edwards HR & PR Foundation - US
06 Payroll

07 Payroll
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Product Code Description

075 Payroll SUI

07Y US Payroll Year End

08 Human Resources

08B Benefits Administration

08C JD Edwards HR Canadian

08H Health and Safety

osp Position Control

08R Recruitment Management

08U JD Edwards HR - US

08W Wage and Salary

09 General Accounting

09E Expense Management (EMS)
10 Financial Reporting

10C Multi-Site Consolidations

11 Multi-Currency/Euro

11C Cash Basis

12 Fixed Assets

13 Equipment Plant Management
14 Modeling, Planning, Budgeting
15 Property Management

16 Profit Management (EPS)

17 Customer Service Management System
17A Ariba Integration

17C Call Management (part of CSMS)
17X Travel & Expense Mgt Powered by Extensity
18 Time Management

19 Utility CIS

20 Energy base

21 Lease Management

2101 MTI Electrical Distribution

22 Production

23 Revenue Distribution

24 Gas Contracts

25 Joint Interest Billing

26 Gas Balancing

27 Investor Services

29 AFE Accounting

30 Product Data Management
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Product Code Description

30A Product Costing

3010 Process Data Management
31 Shop Floor Management
31A Manufacturing Accounting
3110 Process Control

32 Sales Configurator

32C CustomWorks Configurator
33 Capacity Planning

34 Requirements Planning

34A Advanced Planning & Scheduling (APS)
35 Enterprise Facility Planning
36 Forecasting

37 Quality Management

38 Agreement Management

39 Advanced Stock Valuation
40 Inventory/OP Base

4010 Advanced Price Adjustment
41 Inventory Management

41B Bulk Stock Management

42 Sales Management

42A Lead Opportunity Management
42B Sales Order Entry

42E ECS Sales Management

43 Procurement

44 Subcontract Management
44H Homebuilder Management
4401 Homebuilder Management
45 Advanced Pricing

46 Warehouse Management

47 Electronic Commerce

48 Work Order Processing

485 Service Billing

49 Transportation Management
50 Job Cost Base

51 Job Costing (Job Cost Accounting)
52 Contract Billing

53 Change Management

55-59 Reserved for Clients
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Product Code Description

60-69 Reserved for Custom

70 Multi-National Products
71 Client Server Applications
72 WorldVision

73 M&D Complementary Products
74 EMEA Localization

74H Hungary

741 Ireland

74L Portugal

74M Denmark Localization
74N Nordics Localization

740 Norway Localization

74P Poland Localization

74R Russian

74S Spain Localization

74T Turkey

74W Sweden Localization

747 Czech Republic

75 ASEAN Localization

75A Australian Payroll

75C China

75H Thailand Localization

751 India

75K Korea Localization

75N New Zealand

75T Taiwan Localization

757 New Zealand Localization
76 Latin American Localization
76A Argentina Localization
76B Brazil

76C Columbia Localization
76H Chile Localization

76M Payroll (Mexico)

76P Peru Localization

76V Venezuela Localization

77 Canadian Payroll

77Y Canada Payroll Year End
79 Translation Tools
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Product Code Description

80 Business Intelligence

81 DREAM Writer (JD Edwards World software
only)

82 JD Edwards World Writer

83 Management Reporting - FASTR

84 Distributive Data Processing

85 Custom Programming

86 Electronic Doc. Interchange

87 Internal

88 Cautious Purge System

39 Conversion Programs

91 Documentation

92 Computer Assisted Design

93 Computer Assisted Programming

94 Security Officer

95 Sleeper

96 Computer Operations

96P NO INFO ON THIS SYSTEM

97 Software Installation

98 Technical Tools

98E Electronic Burst and Bind

98FT Form Type

98SA Sample Application

99 Technical Tools-Internal

99D Technical Tools-DASD Sizer (reporting syst.
only)

99M Technical Tools-Masters/Update (reporting
syst. only)

99P NO INFO ON THIS SYSTEM

D3N dcLINK (data collection)

HO00 Foundation (UDC only)

HO1 Address Book (incl. ALL mail)

HO3 Accounts Receivable

HO03B New Accounts Receivable

H04 Accounts Payable

HO05 Standalone Time Accounting

HO07 Payroll

HO08 Human Resources

HO09 General Accounting
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Product Code Description

H12 Fixed Assets

H13 Plant/Equipment Mgmt

H15 Commercial Property Management
H30 Product Data Management

H301 Process Data Management

H31 Shop Floor Management

H311 Process Control

H32 Configuration Management

H33 Capacity Requirements Planning
H34 DRP/MRP/MPS

H35 Enterprise Facility Planning

H36 Advanced Forecasting

H40 Inventory/OP Base

H41 Inventory Management

H415 Bulk Inventory Management

H42 Sales Order Processing

H43 Procurement

H44 Contract Management

H44H Homebuilder Management

H45 Sales Analysis

H46 Warehouse Management

H50 Job Cost Base

H72 Client/Server Base

H73 Client Service - A/P Voucher Entry
H74 CS - Pay Time Entry

H75 CS - Sales Order Entry

H76 CS - Training & Development
H78 CS - Travel Expense Management
H79 Translation Tools

H90 JD Edwards Tools

H91 Design Tools

H92 Interactive Engine / OL

H93 Data Base and Communications
H94 Batch Engine

H95 Technical Resources/Applications
H96 Deployment

H97 Automated Testing Tools

H98 Internet
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Product Code Description

H99 Product Version Control

H99P Technical Tools-OWPVC Internal

JE42 Sales Order/Pricing (ECS Enhancements)
JE44 Distribution Contracts (ECS Enhancements)
JE48 Automated Gantry Inter. (ECS Enhancements)
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Quick Reference for Status Codes

This chapter contains the following topics:
= Understanding Status Codes
= Using Codes

13.1 Understanding Status Codes

Status codes identify the status that is associated with a text item. The status enables
editors and translators to make changes according to the change type. Translation tools
use three types of codes to help you identify where items are in the translation process.

= Status
s Reason
| Sklp

13.2 Using Codes

These tables describe some of the codes that you can use. For an up-to-date and
comprehensive list, see the H79 /TS user-defined code list.

13.2.1 Status Codes

Status codes indicate where items are in the translation process. This table describes
some of the status codes that you can use.

Numeric Status Code Description

01 Not Translated. Assign this status to source
terms that you cannot translate into the target
language.

11 Complete. After you have translated an item

and saved it, you must change its status to
complete. All translation tools automatically
change the status to Complete when you save
the translation using the Senior Translations
version.

Only items with a Complete (11) or
Edit/Review (25) status appear in the final
translated software. Therefore, it is extremely
important that you save each translation and
make sure that the status changes to
Complete.
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Numeric Status Code

Description

15

Data Dictionary Default. The Form Design
Aid (FDA) and Report Design Aid (RDA)
translation tools use this status code.

20

Untranslated. This is the untranslated status
for all items in JD Edwards EnterpriseOne
software.

25

Edit (Review). In the Junior Translations
version, the system changes the status to Edit
when you press OK. When another translator
edits the translation and finalizes it, the
system changes the status to Complete (11).

30

Other (Skip Reason). Use the Skip Reason
status to force the source text to appear in the
application.

60: The item contains test data.
61: Unnecessary for all languages.
62: Unnecessary for this language.

64: Waiting for application development.

35

Translation Memory. The item has been
exported to a translation memory and then
reimported to JD Edwards EnterpriseOne
software.

99

Purge from System. The Delta Process
automatically assigns this status; the user
never assigns this status.

13.2.2 Reason Codes

Reason codes define the change to the text. Many items will be set to untranslated with
a type of new item. This table lists reason codes.

Numeric Status Code Description

40 New Item

41 Text and Size Change
42 Text change

43 Minor Text Change
44 Size Change

13.2.3 Skip Codes

Skip Reason codes enable the editor or translator to assign the reason for skipping a
text edit. This table lists skip codes. For an up-to-date and comprehensive list, see the

H79/SR user-defined code list.

Numeric Status Code Description

00 Normal

60 Test Data. The item contains test data.
61 Unnecessary for all languages.
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Numeric Status Code Description

62 Unnecessary for this language. The item is
specific to the U.S. or Canada.

63 Waiting for application developer.

64 Insufficient Length. The translation does not

fit in the allotted space.
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Understanding Jargon and Overrides

This chapter contains the following topic:

s Overrides and Jargon

14.1 Overrides and Jargon

The use of overrides and jargon is the most complex aspect of translating Oracle's JD
Edwards EnterpriseOne software. Jargon and overrides are features that apply to the
Data Dictionary (DD), Form Design Aid (FDA), and Report Design Aid (RDA)
translation tools.

Jargon and overrides tell the software what type of information should appear in
certain situations. Developers apply jargon when modifying items within the data
dictionary, and they apply overrides when modifying the descriptions that appear on
forms.

You might see different text on a form if you run it from the Fast Path field instead of
running it from a task.

Developers must define different field descriptions on the same form depending on
how the programs are called. For example, program P1234 calls form W1234A, which
has a field description abc. If another program calls form W1234A, for example P5678,
then form W1234A displays this field description as xyz instead of abc. This table
illustrates this concept:

Program Called Form Displayed Data ltem
P1234 W1234A abc
P5678 W1234A Xyz

According to programming standards, programmers must program jargon and
overrides without using event rules (ER). Runtime engines run the ER. When you run
a program from the Fast Path field, the runtime engines run this ER.

To understand jargon and overrides, you must first understand the data dictionary.
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Understanding the Data Dictionary

This chapter contains the following topics:

The Data Dictionary
Data Dictionary Jargon

FDA Overrides

15.1 The Data Dictionary

Oracle's JD Edwards EnterpriseOne data dictionary (DD) stores the descriptions for all
the controls, text fields, buttons, F1 help, and other items that appear on forms in JD
Edwards EnterpriseOne software. Each data dictionary item contains four
descriptions: alpha description, row description, column description, and glossary.

Alpha description.

The alpha description is the title of the F1 help in JD Edwards EnterpriseOne
software, which is the glossary entry in the software.

Row description.

When a data dictionary item is used as a control, such as a field, check box, or
radio button, the row description is used as the text for the control.

Column description.

When the data dictionary item is used as a grid item, such as a column heading in
a report or form, the column description is used as the text for the grid item.

Glossary.

The glossary is the help text that appears when a user presses F1. It explains what
a field in a form means or how it is used in the software. The alpha description
appears as the title of the help text.

15.2 Data Dictionary Jargon

This section discusses:

Jargon fundamentals.
Alpha jargon.

Row and column jargon.
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15.2.1 Jargon Fundamentals

Each data dictionary item can be used on many different forms. As developers use and
reuse data dictionary items, they can modify the descriptions for the items. To do this,
they apply jargon. Jargon enables developers to customize data dictionary text so that
an alternate description appears, depending on the context and system code in which
the item is used.

Developers can apply two types of jargon to data dictionary items:
= Alpha and glossary
= Row and column

Jargon is applied to form controls and grid items when the data dictionary default
value is used. Using the data dictionary is always preferred because terminology
changes can be managed through the data dictionary instead of a form-by-form
vocabulary override basis. When a translator overrides the item with a specific
translation, jargon can no longer be applied. In the case that jargon does not exist, you
should work with content developers or product experts to add new jargon
terminology to the data dictionary so that the proper jargon translation can be applied
during runtime processing.

Note: If you create an override for a translation item, that translation
item is static and cannot be used dynamically anywhere else. You will
have to maintain overrides individually. Therefore, you should use the
data dictionary default values whenever possible.

15.2.2 Alpha Jargon

When a new glossary entry, or F1 help, is applied to an item, the developer changes
the alpha description because it is the title of the F1 help. In these instances, a
developer would apply alpha jargon.

Alpha jargon can apply to individual forms or entire systems. For instance, when a
data dictionary item is used in the same context throughout an entire system, the
developer would apply system-level alpha jargon. When an item is used in a different
context in only one form, the developer would apply form-level alpha jargon.

In this example, the data item ANS has both system-level jargon (identified by 12, 15,
19, and so on in the Product Code Reporting column) and form-level jargon (identified
by W03013B, W0401A, W0474N3B, and so on in the ScrnRpt Name column) applied.

15.2.3 Row and Column Jargon

Developers apply row and column jargon when they want a description other than the
base description to appear on a form. Row and column jargon can apply only to entire
systems.

For example, the base description for the data dictionary item ANS is Address Book
Number. When the data item is used without any jargon, the system displays it as
Address Number.

However, when used in Product Code 42 (Sales Management), the item is more
appropriately described as Sold To.

The new description, Sold To, is a new data dictionary item. This new item appears as
Product Code 00 with a reporting code of 42. In this instance, all forms in system 42
that contain the data dictionary item ANS will display Sold To.
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When you translate row and column jargon, the DD translation tool updates the status
of each form item in which the jargon data dictionary item is used to DD Default
(status = 15). When you begin translating forms, you must search for all items with a
DD Default (status = 15) and verify that the translation fits in the allotted space on the
individual forms.

15.3 FDA Overrides

Overrides are similar to jargon except that they occur at the form level. The two types
of FDA overrides are English and Translation. This section discusses:

= English overrides.

» Language overrides.

15.3.1 English Overrides

JD Edwards forms can be reused in multiple systems. In these cases, developers apply
English overrides to data dictionary items and enter alternate descriptions. Developers
can apply English overrides to specific forms but not to entire systems.

For example, when a form is called from system 30, a text field might be described as
Customer Number. When called from system 31, the same text field might be
described as Address Book Number. When you translate the forms in system 30, you
will see only the description Customer Number.

When an English override exists, the translation is automatically overridden.

Note: In the FDA Translation Tool, you can view the items that have
overrides. Items that have overrides have a check mark in the Text
Overridden check box.

15.3.2 Language Overrides

As a translator, you can enter a language override when the description of an item
does not fit the context of the form. A translation override applies only to the item as it
is used on a particular form. Although these circumstances might require language
overrides, use language overrides sparingly:

»  The data dictionary translation does not fit in the allotted space in a form.

» The data dictionary translation is not appropriate for the context.

Understanding the Data Dictionary 15-3



FDA Overrides

15-4 JD Edwards EnterpriseOne Tools Translation Tools Guide



Glossary

Accessor Methods/Assessors

Java methods to “get” and “set” the elements of a value object or other source file.

activity rule

The criteria by which an object progresses from one given point to the next in a flow.

add mode

A condition of a form that enables users to input data.

Advanced Planning Agent (APAg)

A JD Edwards EnterpriseOne tool that can be used to extract, transform, and load
enterprise data. APAg supports access to data sources in the form of rational
databases, flat file format, and other data or message encoding, such as XML.

application server

Software that provides the business logic for an application program in a distributed
environment. The servers can be Oracle Application Server (OAS) or WebSphere
Application Server (WAS).

Auto Commit Transaction

A database connection through which all database operations are immediately written
to the database.

batch processing

A process of transferring records from a third-party system to JD Edwards
EnterpriseOne.

In JD Edwards EnterpriseOne Financial Management, batch processing enables you to
transfer invoices and vouchers that are entered in a system other than JD Edwards
EnterpriseOne to JD Edwards EnterpriseOne Accounts Receivable and JD Edwards
EnterpriseOne Accounts Payable, respectively. In addition, you can transfer address
book information, including customer and supplier records, to JD Edwards
EnterpriseOne.

batch server

A server that is designated for running batch processing requests. A batch server
typically does not contain a database nor does it run interactive applications.
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Glossary-2

batch-of-one

A transaction method that enables a client application to perform work on a client
workstation, then submit the work all at once to a server application for further
processing. As a batch process is running on the server, the client application can
continue performing other tasks.

best practices

Non-mandatory guidelines that help the developer make better design decisions.

BPEL

Abbreviation for Business Process Execution Language, a standard web services
orchestration language, which enables you to assemble discrete services into an
end-to-end process flow.

BPEL PM

Abbreviation for Business Process Execution Language Process Manager, a
comprehensive infrastructure for creating, deploying, and managing BPEL business
processes.

Build Configuration File

Configurable settings in a text file that are used by a build program to generate ANT
scripts. ANT is a software tool used for automating build processes. These scripts
build published business services.

build engineer

An actor that is responsible for building, mastering, and packaging artifacts. Some
build engineers are responsible for building application artifacts, and some are
responsible for building foundation artifacts.

Build Program

A WINB32 executable that reads build configuration files and generates an ANT script
for building published business services.

business analyst

An actor that determines if and why an EnterpriseOne business service needs to be
developed.

business function

A named set of user-created, reusable business rules and logs that can be called
through event rules. Business functions can run a transaction or a subset of a
transaction (check inventory, issue work orders, and so on). Business functions also
contain the application programming interfaces (APIs) that enable them to be called
from a form, a database trigger, or a non-JD Edwards EnterpriseOne application.
Business functions can be combined with other business functions, forms, event rules,
and other components to make up an application. Business functions can be created
through event rules or third-generation languages, such as C. Examples of business
functions include Credit Check and Item Availability.

business function event rule

See named event rule (NER).
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business service

EnterpriseOne business logic written in Java. A business service is a collection of one
or more artifacts. Unless specified otherwise, a business service implies both a
published business service and business service.

business service artifacts

Source files, descriptors, and so on that are managed for business service development
and are needed for the business service build process.

business service class method

A method that accesses resources provided by the business service framework.

business service configuration files

Configuration files include, but are not limited to, interop.ini, JDBj.ini, and
jdelog.properties.

business service cross reference

A key and value data pair used during orchestration. Collectively refers to both the
code and the key cross reference in the WSG/XPI based system.

business service cross-reference utilities

Utility services installed in a BPEL/ESB environment that are used to access JD
Edwards EnterpriseOne orchestration cross-reference data.

business service development environment

A framework needed by an integration developer to develop and manage business
services.

business services development tool

Otherwise known as JDeveloper.

business service EnterpriseOne object

A collection of artifacts managed by EnterpriseOne LCM tools. Named and
represented within EnterpriseOne LCM similarly to other EnterpriseOne objects like
tables, views, forms, and so on.

business service framework

Parts of the business service foundation that are specifically for supporting business
service development.

business service payload

An object that is passed between an enterprise server and a business services server.
The business service payload contains the input to the business service when passed to
the business services server. The business service payload contains the results from the
business service when passed to the Enterprise Server. In the case of notifications, the
return business service payload contains the acknowledgement.

business service property

Key value data pairs used to control the behavior or functionality of business services.

Business Service Property Admin Tool

An EnterpriseOne application for developers and administrators to manage business
service property records.
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business service property business service group

A classification for business service property at the business service level. This is
generally a business service name. A business service level contains one or more
business service property groups. Each business service property group may contain
zero or more business service property records.

business service property key

A unique name that identifies the business service property globally in the system.

business service property utilities

A utility API used in business service development to access EnterpriseOne business
service property data.

business service property value

A value for a business service property.

business service repository

A source management system, for example ClearCase, where business service artifacts
and build files are stored. Or, a physical directory in network.

business services server

The physical machine where the business services are located. Business services are
run on an application server instance.

business services source file or business service class

One type of business service artifact. A text file with the java file type written to be
compiled by a Java compiler.

business service value object template

The structural representation of a business service value object used in a C-business
function.

Business Service Value Object Template Utility

A utility used to create a business service value object template from a business service
value object.

business services server artifact

The object to be deployed to the business services server.

business view

A means for selecting specific columns from one or more JD Edwards EnterpriseOne
application tables whose data is used in an application or report. A business view does
not select specific rows, nor does it contain any actual data. It is strictly a view through
which you can manipulate data.

central objects merge

A process that blends a customer's modifications to the objects in a current release
with objects in a new release.

central server

A server that has been designated to contain the originally installed version of the
software (central objects) for deployment to client computers. In a typical JD Edwards
EnterpriseOne installation, the software is loaded on to one machine—the central



database credentials

server. Then, copies of the software are pushed out or downloaded to various
workstations attached to it. That way, if the software is altered or corrupted through its
use on workstations, an original set of objects (central objects) is always available on
the central server.

charts

Tables of information in JD Edwards EnterpriseOne that appear on forms in the
software.

check-in repository

A repository for developers to check in and check out business service artifacts. There
are multiple check-in repositories. Each can be used for a different purpose (for
example, development, production, testing, and so on).

checksum

A fixed-size datum computed from an arbitrary block of digital data for the purpose of
detecting accidental errors that may have been introduced during its transmission or
storage. JD Edwards EnterpriseOne uses the checksum to verify the integrity of
packages that have been downloaded by recomputing the checksum of the
downloaded package and comparing it with the checksum of the original package.
The procedure that yields the checksum from the data is called a checksum function or
checksum algorithm. JD Edwards EnterpriseOne uses the MD5 and STA-1 checksum
algorithms.

connector

Component-based interoperability model that enables third-party applications and JD
Edwards EnterpriseOne to share logic and data. The JD Edwards EnterpriseOne
connector architecture includes Java and COM connectors.

Control Table Workbench

An application that, during the Installation Workbench processing, runs the batch
applications for the planned merges that update the data dictionary, user-defined
codes, menus, and user override tables.

control tables merge

A process that blends a customer's modifications to the control tables with the data
that accompanies a new release.

correlation data

The data used to tie HTTP responses with requests that consist of business service
name and method.

credentials

A valid set of ]D Edwards EnterpriseOne username/password/environment/role,
EnterpriseOne session, or EnterpriseOne token.

cross-reference utility services

Utility services installed in a BPEL/ESB environment that access EnterpriseOne
cross-reference data.

database credentials

A valid database username/password.
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database server

A server in a local area network that maintains a database and performs searches for
client computers.

Data Source Workbench

An application that, during the Installation Workbench process, copies all data sources
that are defined in the installation plan from the Data Source Master and Table and
Data Source Sizing tables in the Planner data source to the system-release number data
source. It also updates the Data Source Plan detail record to reflect completion.

deployment artifacts

Artifacts that are needed for the deployment process, such as servers, ports, and such.

deployment server

A server that is used to install, maintain, and distribute software to one or more
enterprise servers and client workstations.

direct connect

A transaction method in which a client application communicates interactively and
directly with a server application.

See also batch-of-one and store-and-forward.

Do Not Translate (DNT)

A type of data source that must exist on the iSeries because of BLOB restrictions.

embedded application server instance
An OC4] instance started by and running wholly within JDeveloper.

edit code

A code that indicates how a specific value for a report or a form should appear or be
formatted. The default edit codes that pertain to reporting require particular attention
because they account for a substantial amount of information.

edit mode

A condition of a form that enables users to change data.

edit rule

A method used for formatting and validating user entries against a predefined rule or
set of rules.

Electronic Data Interchange (EDI)

An interoperability model that enables paperless computer-to-computer exchange of
business transactions between JD Edwards EnterpriseOne and third-party systems.
Companies that use EDI must have translator software to convert data from the EDI
standard format to the formats of their computer systems.

embedded event rule

An event rule that is specific to a particular table or application. Examples include
form-to-form calls, hiding a field based on a processing option value, and calling a
business function. Contrast with the business function event rule.



Environment Workbench

Employee Work Center

A central location for sending and receiving all JD Edwards EnterpriseOne messages
(system and user generated), regardless of the originating application or user. Each
user has a mailbox that contains workflow and other messages, including Active
Messages.

enterprise server

A server that contains the database and the logic for JD Edwards EnterpriseOne.

Enterprise Service Bus (ESB)

Middleware infrastructure products or technologies based on web services standards
that enable a service-oriented architecture using an event-driven and XML-based
messaging framework (the bus).

EnterpriseOne administrator

An actor responsible for the EnterpriseOne administration system.

EnterpriseOne credentials

A user ID, password, environment, and role used to validate a user of EnterpriseOne.

EnterpriseOne development client

Historically called “fat client,” a collection of installed EnterpriseOne components
required to develop EnterpriseOne artifacts, including the Microsoft Windows client
and design tools.

EnterpriseOne extension

A JDeveloper component (plug-in) specific to EnterpriseOne. A JDeveloper wizard

is a specific example of an extension.

EnterpriseOne object

A reusable piece of code that is used to build applications. Object types include tables,
forms, business functions, data dictionary items, batch processes, business views,
event rules, versions, data structures, and media objects.

EnterpriseOne process

A software process that enables JD Edwards EnterpriseOne clients and servers to
handle processing requests and run transactions. A client runs one process, and
servers can have multiple instances of a process. JD Edwards EnterpriseOne processes
can also be dedicated to specific tasks (for example, workflow messages and data
replication) to ensure that critical processes don't have to wait if the server is
particularly busy.

EnterpriseOne resource

Any EnterpriseOne table, metadata, business function, dictionary information, or
other information restricted to authorized users.

Environment Workbench

An application that, during the Installation Workbench process, copies the
environment information and Object Configuration Manager tables for each
environment from the Planner data source to the system-release number data source. It
also updates the Environment Plan detail record to reflect completion.
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escalation monitor

A batch process that monitors pending requests or activities and restarts or forwards
them to the next step or user after they have been inactive for a specified amount of
time.

event rule

A logic statement that instructs the system to perform one or more operations based
on an activity that can occur in a specific application, such as entering a form or exiting
a field.

explicit transaction

Transaction used by a business service developer to explicitly control the type (auto or
manual) and the scope of transaction boundaries within a business service.

exposed method or value object

Published business service source files or parts of published business service source
files that are part of the published interface. These are part of the contract with the
customer.

fast path

A command prompt that enables the user to move quickly among menus and
applications by using specific commands.

file server

A server that stores files to be accessed by other computers on the network. Unlike a
disk server, which appears to the user as a remote disk drive, a file server is a
sophisticated device that not only stores files, but also manages them and maintains
order as network users request files and make changes to these files.

final mode

The report processing mode of a processing mode of a program that updates or creates
data records.

foundation

A framework that must be accessible for execution of business services at runtime.
This includes, but is not limited to, the Java Connector and JDB;.

FTP server

A server that responds to requests for files via file transfer protocol.

HTTP Adapter

A generic set of services that are used to do the basic HTTP operations, such as GET,
POST, PUT, DELETE, TRACE, HEAD, and OPTIONS with the provided URL.
instantiate

A Java term meaning “to create.” When a class is instantiated, a new instance

is created.

integration developer

The user of the system who develops, runs, and debugs the EnterpriseOne business
services. The integration developer uses the EnterpriseOne business services to
develop these components.
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integration point (IP)

The business logic in previous implementations of EnterpriseOne that exposes a
document level interface. This type of logic used to be called XBPs. In EnterpriseOne
8.11, IPs are implemented in Web Services Gateway powered by webMethods.
integration server

A server that facilitates interaction between diverse operating systems and
applications across internal and external networked computer systems.

integrity test
A process used to supplement a company’s internal balancing procedures by locating
and reporting balancing problems and data inconsistencies.

interface table
See Z table.

internal method or value object

Business service source files or parts of business service source files that are not part of
the published interface. These could be private or protected methods. These could be
value objects not used in published methods.

interoperability model

A method for third-party systems to connect to or access JD Edwards EnterpriseOne.

in-your-face error

In JD Edwards EnterpriseOne, a form-level property which, when enabled, causes the
text of application errors to appear on the form.

jargon
An alternative data dictionary item description that JD Edwards EnterpriseOne
appears based on the product code of the current object.

Java application server

A component-based server that resides in the middle-tier of a server-centric
architecture. This server provides middleware services for security and state
maintenance, along with data access and persistence.

JDBNET

A database driver that enables heterogeneous servers to access each other's data.

JDEBASE Database Middleware

A JD Edwards EnterpriseOne proprietary database middleware package that provides
platform-independent APIs, along with client-to-server access.

JDECallObject

An API used by business functions to invoke other business functions.

jde.ini

A JD Edwards EnterpriseOne file (or member for iSeries) that provides the runtime
settings required for JD Edwards EnterpriseOne initialization. Specific versions of the

file or member must reside on every machine running JD Edwards EnterpriseOne.
This includes workstations and servers.
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JDEIPC

Communications programming tools used by server code to regulate access to the
same data in multiprocess environments, communicate and coordinate between
processes, and create new processes.

jde.log

The main diagnostic log file of JD Edwards EnterpriseOne. This file is always located
in the root directory on the primary drive and contains status and error messages from
the startup and operation of JD Edwards EnterpriseOne.

JDENET

A JD Edwards EnterpriseOne proprietary communications middleware package. This
package is a peer-to-peer, message-based, socket-based, multiprocess communications
middleware solution. It handles client-to-server and server-to-server communications
for all JD Edwards EnterpriseOne supported platforms.

JDeveloper Project

An artifact that JDeveloper uses to categorize and compile source files.

JDeveloper Workspace

An artifact that JDeveloper uses to organize project files. It contains one or more
project files.

JMS Queue

A Java Messaging service queue used for point-to-point messaging.

listener service
A listener that listens for XML messages over HTTP.

local repository

A developer’s local development environment that is used to store business service
artifacts.

Location Workbench

An application that, during the Installation Workbench process, copies all locations
that are defined in the installation plan from the Location Master table in the Planner
data source to the system data source.

logic server

A server in a distributed network that provides the business logic for an application
program. In a typical configuration, pristine objects are replicated on to the logic
server from the central server. The logic server, in conjunction with workstations,
actually performs the processing required when JD Edwards EnterpriseOne software
runs.

MailMerge Workbench

An application that merges Microsoft Word 6.0 (or higher) word-processing
documents with JD Edwards EnterpriseOne records to automatically print business
documents. You can use MailMerge Workbench to print documents, such as form
letters about verification of employment.
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Manual Commit transaction

A database connection where all database operations delay writing to the database
until a call to commit is made.

master business function (MBF)

An interactive master file that serves as a central location for adding, changing, and
updating information in a database. Master business functions pass information
between data entry forms and the appropriate tables. These master functions provide a
common set of functions that contain all of the necessary default and editing rules for
related programs. MBFs contain logic that ensures the integrity of adding, updating,
and deleting information from databases.

master table
See published table.

media storage object

Files that use one of the following naming conventions that are not organized into
table format: Gxxx, xxxGT, or GTxxx.

message center

A central location for sending and receiving all JD Edwards EnterpriseOne messages
(system and user generated), regardless of the originating application or user.

messaging adapter

An interoperability model that enables third-party systems to connect to JD Edwards
EnterpriseOne to exchange information through the use of messaging queues.

messaging server

A server that handles messages that are sent for use by other programs using a
messaging API. Messaging servers typically employ a middleware program to
perform their functions.

Monitoring Application

An EnterpriseOne tool provided for an administrator to get statistical information for
various EnterpriseOne servers, reset statistics, and set notifications.

named event rule (NER)

Encapsulated, reusable business logic created using event rules, rather that C
programming. NERs are also called business function event rules. NERs can be reused
in multiple places by multiple programs. This modularity lends itself to streamlining,
reusability of code, and less work.

Object Configuration Manager (OCM)

In JD Edwards EnterpriseOne, the object request broker and control center for the
runtime environment. OCM keeps track of the runtime locations for business

functions, data, and batch applications. When one of these objects is called, OCM
directs access to it using defaults and overrides for a given environment and user.

Object Librarian

A repository of all versions, applications, and business functions reusable in building
applications. Object Librarian provides check-out and check-incapabilities for
developers, and it controls the creation, modification, and use of JD Edwards
EnterpriseOne objects. Object Librarian supports multiple environments (such as
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production and development) and enables objects to be easily moved from one
environment to another.

Object Librarian merge

A process that blends any modifications to the Object Librarian in a previous release
into the Object Librarian in a new release.

Open Data Access (ODA)

An interoperability model that enables you to use SQL statements to extract JD
Edwards EnterpriseOne data for summarization and report generation.

Output Stream Access (OSA)

An interoperability model that enables you to set up an interface for JD Edwards
EnterpriseOne to pass data to another software package, such as Microsoft Excel, for
processing.

package

JD Edwards EnterpriseOne objects are installed to workstations in packages from the
deployment server. A package can be compared to a bill of material or kit that
indicates the necessary objects for that workstation and where on the deployment
server the installation program can find them. It is point-in-time snapshot of the
central objects on the deployment server.

package build

A software application that facilitates the deployment of software changes and new
applications to existing users. Additionally, in JD Edwards EnterpriseOne, a package
build can be a compiled version of the software. When you upgrade your version of
the ERP software, for example, you are said to take a package build.

Consider the following context: “Also, do not transfer business functions into the
production path code until you are ready to deploy, because a global build of business
functions done during a package build will automatically include the new functions.”
The process of creating a package build is often referred to, as it is in this example,
simply as “a package build.”

package location

The directory structure location for the package and its set of replicated objects. This is
usually \\deployment server\release\path_code\package\package name. The
subdirectories under this path are where the replicated objects for the package are
placed. This is also referred to as where the package is built or stored.

Package Workbench

An application that, during the Installation Workbench process, transfers the package
information tables from the Planner data source to the system-release number data
source. It also updates the Package Plan detail record to reflect completion.

Pathcode Directory
The specific portion of the file system on the EnterpriseOne development client where
EnterpriseOne development artifacts are stored.

patterns

General repeatable solutions to a commonly occurring problem in software design. For
business service development, the focus is on the object relationships and interactions.



published business service

For orchestrations, the focus is on the integration patterns (for example, synchronous
and asynchronous request/response, publish, notify, and receive/reply).

print server

The interface between a printer and a network that enables network clients to connect
to the printer and send their print jobs to it. A print server can be a computer, separate
hardware device, or even hardware that resides inside of the printer itself.

pristine environment

A JD Edwards EnterpriseOne environment used to test unaltered objects with JD
Edwards EnterpriseOne demonstration data or for training classes. You must have this
environment so that you can compare pristine objects that you modify.

processing option

A data structure that enables users to supply parameters that regulate the running of a
batch program or report. For example, you can use processing options to specify
default values for certain fields, to determine how information appears or is printed,
to specify date ranges, to supply runtime values that regulate program execution, and
SO on.

production environment

A JD Edwards EnterpriseOne environment in which users operate EnterpriseOne
software.

Production Published Business Services Web Service

Published business services web service deployed to a production application server.

program temporary fix (PTF)

A representation of changes to JD Edwards EnterpriseOne software that your
organization receives on magnetic tapes or disks.

project

In JD Edwards EnterpriseOne, a virtual container for objects being developed in Object
Management Workbench.

promotion path

The designated path for advancing objects or projects in a workflow. The following is
the normal promotion cycle (path):

11>21>26>28>38>01

In this path, 11 equals new project pending review, 21 equals programming, 26 equals
QA test/review, 28 equals QA test/review complete, 38 equals in production, 01
equals complete. During the normal project promotion cycle, developers check objects
out of and into the development path code and then promote them to the prototype
path code. The objects are then moved to the productions path code before declaring
them complete.

proxy server

A server that acts as a barrier between a workstation and the internet so that the
enterprise can ensure security, administrative control, and caching service.
published business service

EnterpriseOne service level logic and interface. A classification of a published business
service indicating the intention to be exposed to external (non-EnterpriseOne) systems.
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published business service identification information

Information about a published business service used to determine relevant
authorization records. Published business services + method name, published business
services, or *ALL.

published business service web service

Published business services components packaged as J2EE Web Service (namely, a
J2EE EAR file that contains business service classes, business service foundation,
configuration files, and web service artifacts).

published table

Also called a master table, this is the central copy to be replicated to other machines.
Residing on the publisher machine, the FO98DRPUB table identifies all of the published
tables and their associated publishers in the enterprise.

publisher

The server that is responsible for the published table. The FO8DRPUB table identifies
all of the published tables and their associated publishers in the enterprise.

QBE

An abbreviation for query by example. In JD Edwards EnterpriseOne, the QBE line is
the top line on a detail area that is used for filtering data.

real-time event

A message triggered from EnterpriseOne application logic that is intended for external
systems to consume.

refresh

A function used to modify JD Edwards EnterpriseOne software, or subset of it, such as
a table or business data, so that it functions at a new release or cumulative update
level.

replication server

A server that is responsible for replicating central objects to client machines.

rules

Mandatory guidelines that are not enforced by tooling, but must be followed in order
to accomplish the desired results and to meet specified standards.

secure by default

A security model that assumes that a user does not have permission to execute an
object unless there is a specific record indicating such permissions.

Secure Socket Layer (SSL)

A security protocol that provides communication privacy. SSL enables client and
server applications to communicate in a way that is designed to prevent
eavesdropping, tampering, and message forgery.

selection

Found on JD Edwards EnterpriseOne menus, a selection represents functions that you
can access from a menu. To make a selection, type the associated number in the
Selection field and press Enter.



super class

serialize

The process of converting an object or data into a format for storage or transmission
across a network connection link with the ability to reconstruct the original data or
objects when needed.

Server Workbench

An application that, during the Installation Workbench process, copies the server
configuration files from the Planner data source to the system-release number data
source. The application also updates the Server Plan detail record to reflect
completion.

SOA

Abbreviation for Service Oriented Architecture.

softcoding

A coding technique that enables an administrator to manipulate site-specific variables
that affect the execution of a given process.

source repository

A repository for HTTP adapter and listener service development environment
artifacts.

Specification merge

A merge that comprises three merges: Object Librarian merge, Versions List merge,
and Central Objects merge. The merges blend customer modifications with data that
accompanies a new release.

specification

A complete description of a JD Edwards EnterpriseOne object. Each object has its own
specification, or name, which is used to build applications.

Specification Table Merge Workbench

An application that, during the Installation Workbench process, runs the batch
applications that update the specification tables.

SSL Certificate

A special message signed by a certificate authority that contains the name of a user
and that user's public key in such a way that anyone can "verify" that the message was
signed by no one other than the certification authority and thereby develop trust in the
user's public key.

store-and-forward

The mode of processing that enables users who are disconnected from a server to enter
transactions and then later connect to the server to upload those transactions.
subscriber table

Table F98DRSUB, which is stored on the publisher server with the FO8DRPUB table
and identifies all of the subscriber machines for each published table.

super class

An inheritance concept of the Java language where a class is an instance of something,
but is also more specific. “Tree” might be the super class of “Oak” and “Elm,” for
example.
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table access management (TAM)

The JD Edwards EnterpriseOne component that handles the storage and retrieval of
use-defined data. TAM stores information, such as data dictionary definitions;
application and report specifications; event rules; table definitions; business function
input parameters and library information; and data structure definitions for running
applications, reports, and business functions.

Table Conversion Workbench

An interoperability model that enables the exchange of information between JD
Edwards EnterpriseOne and third-party systems using non-JD Edwards
EnterpriseOne tables.

table conversion

An interoperability model that enables the exchange of information between JD
Edwards EnterpriseOne and third-party systems using non-JD Edwards
EnterpriseOne tables.

table event rules

Logic that is attached to database triggers that runs whenever the action specified by
the trigger occurs against the table. Although JD Edwards EnterpriseOne enables
event rules to be attached to application events, this functionality is application
specific. Table event rules provide embedded logic at the table level.

terminal server

A server that enables terminals, microcomputers, and other devices to connect to a
network or host computer or to devices attached to that particular computer.

transaction processing (TP) monitor

A monitor that controls data transfer between local and remote terminals and the
applications that originated them. TP monitors also protect data integrity in the
distributed environment and may include programs that validate data and format
terminal screens.

transaction processing method

A method related to the management of a manual commit transaction boundary (for
example, start, commit, rollback, and cancel).

transaction set

An electronic business transaction (electronic data interchange standard document)
made up of segments.

trigger

One of several events specific to data dictionary items. You can attach logic to a data
dictionary item that the system processes automatically when the event occurs.
triggering event

A specific workflow event that requires special action or has defined consequences or
resulting actions.

user identification information

User ID, role, or *public.



web service softcoding template

User Overrides merge

Adds new user override records into a customer’s user override table.

value object

A specific type of source file that holds input or output data, much like a data
structure passes data. Value objects can be exposed (used in a published business
service) or internal, and input or output. They are comprised of simple and complex
elements and accessories to those elements.

versioning a published business service

Adding additional functionality /interfaces to the published business services without
modifying the existing functionality /interfaces.

Versions List merge

The Versions List merge preserves any non-XJDE and non-Z]DE version specifications
for objects that are valid in the new release, as well as their processing options data.
visual assist

Forms that can be invoked from a control via a trigger to assist the user in determining
what data belongs in the control.

vocabulary override

An alternate description for a data dictionary item that appears on a specific JD
Edwards EnterpriseOne form or report.

web application server

A web server that enables web applications to exchange data with the back-end
systems and databases used in eBusiness transactions.

web server

A server that sends information as requested by a browser, using the TCP/IP set of
protocols. A web server can do more than just coordination of requests from browsers;
it can do anything a normal server can do, such as house applications or data. Any
computer can be turned into a web server by installing server software and connecting
the machine to the internet.

Web Service Description Language (WSDL)

An XML format for describing network services.

Web Service Inspection Language (WSIL)

An XML format for assisting in the inspection of a site for available services and a set
of rules for how inspection-related information should be made.

web service softcoding record

An XML document that contains values that are used to configure a web service proxy.
This document identifies the endpoint and conditionally includes security
information.

web service softcoding template

An XML document that provides the structure for a soft coded record.
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Where clause

The portion of a database operation that specifies which records the database
operation will affect.

Windows terminal server

A multiuser server that enables terminals and minimally configured computers to
display Windows applications even if they are not capable of running Windows
software themselves. All client processing is performed centrally at the Windows
terminal server and only display, keystroke, and mouse commands are transmitted
over the network to the client terminal device.

wizard

A type of JDeveloper extension used to walk the user through a series of steps.

workbench

A program that enables users to access a group of related programs from a single entry
point. Typically, the programs that you access from a workbench are used to complete
a large business process. For example, you use the JD Edwards EnterpriseOne Payroll
Cycle Workbench (P07210) to access all of the programs that the system uses to process
payroll, print payments, create payroll reports, create journal entries, and update
payroll history. Examples of JD Edwards EnterpriseOne workbenches include Service
Management Workbench (P90CD020), Line Scheduling Workbench (P3153), Planning
Workbench (P13700), Auditor's Workbench (P09E115), and Payroll Cycle Workbench.

workflow

The automation of a business process, in whole or in part, during which documents,
information, or tasks are passed from one participant to another for action, according
to a set of procedural rules.

workgroup server
A server that usually contains subsets of data replicated from a master network server.
A workgroup server does not perform application or batch processing.

XAPI events

A service that uses system calls to capture JD Edwards EnterpriseOne transactions as
they occur and then calls third-party software, end users, and other JD Edwards
EnterpriseOne systems that have requested notification when the specified
transactions occur to return a response.

XML CallObject

An interoperability capability that enables you to call business functions.

XML Dispatch

An interoperability capability that provides a single point of entry for all XML
documents coming into JD Edwards EnterpriseOne for responses.

XML List

An interoperability capability that enables you to request and receive JD Edwards
EnterpriseOne database information in chunks.



Z transaction

XML Service

An interoperability capability that enables you to request events from one JD Edwards
EnterpriseOne system and receive a response from another JD Edwards EnterpriseOne
system.

XML Transaction

An interoperability capability that enables you to use a predefined transaction type to
send information to or request information from JD Edwards EnterpriseOne. XML
transaction uses interface table functionality.

XML Transaction Service (XTS)

Transforms an XML document that is not in the JD Edwards EnterpriseOne format
into an XML document that can be processed by JD Edwards EnterpriseOne. XTS then
transforms the response back to the request originator XML format.

Z event

A service that uses interface table functionality to capture JD Edwards EnterpriseOne
transactions and provide notification to third-party software, end users, and other JD
Edwards EnterpriseOne systems that have requested to be notified when certain
transactions occur.

Z table

A working table where non-JD Edwards EnterpriseOne information can be stored and
then processed into JD Edwards EnterpriseOne. Z tables also can be used to retrieve JD
Edwards EnterpriseOne data. Z tables are also known as interface tables.

Z transaction

Third-party data that is properly formatted in interface tables for updating to the JD
Edwards EnterpriseOne database.
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